Norton Ghost™
User’s Guide

The software described in this book is furnished under a license agreement and may be used only in accordance with the terms of the agreement.

Documentation version 6.7
PN: 07-50-00472

Copyright Notice
All Rights Reserved.
Any technical documentation that is made available by Symantec Corporation is the copyrighted work of Symantec Corporation and is owned by Symantec Corporation.

NO WARRANTY. The technical documentation is being delivered to you AS-IS and Symantec Corporation makes no warranty as to its accuracy or use. Any use of the technical documentation or the information contained therein is at the risk of the user. Documentation may include technical or other inaccuracies or typographical errors. Symantec reserves the right to make changes without prior notice.

No part of this publication may be copied without the express written permission of Symantec Corporation, 20350 Stevens Creek Boulevard, Cupertino, CA 95014.

Trademarks
Symantec, the Symantec logo, Symantec Ghost, Norton Ghost, Ghost Walker, Ghost Explorer, and GDisk are trademarks of Symantec Corporation.
Microsoft, MS-DOS, Windows, and Windows NT are registered trademarks of Microsoft Corporation. IBM, OS/2, and OS/2 Warp are registered trademarks of International Business Machines Corporation. Novell and NetWare are registered trademarks of Novell Corporation. 3Com and EtherLink are registered trademarks of 3Com Corporation. Compaq is a registered trademark of Compaq Corporation. Zip and Jaz are registered trademarks of Iomega Corporation. SuperDisk is a trademark of Imation Enterprises Corporation.
Other product names mentioned in this manual may be trademarks or registered trademarks of their respective companies and are hereby acknowledged.

Printed in the United States of America.
10 9 8 7 6 5 4 3 2 1
SYMANTEC LICENSE AND WARRANTY

SYMANTEC CORPORATION AND/OR ITS SUBSIDIARIES ("SYMANTEC") IS WILLING TO LICENSE THE SOFTWARE TO YOU AS AN INDIVIDUAL, THE COMPANY, OR THE LEGAL ENTITY THAT WILL BE UTILIZING THE SOFTWARE (REFERRED TO BELOW AS "YOU OR YOUR") ONLY ON THE CONDITION THAT YOU ACCEPT ALL OF THE TERMS OF THIS LICENSE AGREEMENT. READ THE TERMS AND CONDITIONS OF THIS LICENSE AGREEMENT CAREFULLY BEFORE USING THE SOFTWARE. THIS IS A LEGAL AND ENFORCEABLE CONTRACT BETWEEN YOU AND THE LICENSOR. BY OPENING THIS PACKAGE, BREAKING THE SEAL, CLICKING ON THE "AGREE" OR "YES" BUTTON OR OTHERWISE INDICATING ASSENT ELECTRONICALLY, OR LOADING THE SOFTWARE, YOU AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO THESE TERMS AND CONDITIONS, CLICK ON THE "I DO NOT AGREE", "NO" BUTTON, OR OTHERWISE INDICATE REFUSAL, MAKE NO FURTHER USE OF THE SOFTWARE, AND RETURN THE FULL PRODUCT WITH PROOF OF PURCHASE TO THE DEALER FROM WHOM IT WAS ACQUIRED WITHIN SIXTY (60) DAYS OF PURCHASE, AND YOUR MONEY WILL BE REFUNDED.

LICENSE AND WARRANTY:

The software which accompanies this license (the "Software") is the property of Symantec or its licensors and is protected by copyright law. While Symantec continues to own the Software, you will have certain rights to use the Software after your acceptance of this license. This license governs any releases, revisions, or enhancements to the Software that the Licensor may furnish to you. Except as may be modified by a Symantec license certificate, license coupon, or license key (each a "License Module") which accompanies, precedes, or follows this license, your rights and obligations with respect to the use of this Software are as follows:

You may:

(i) use the Software on one computer to clone, or apply an image of, a hard drive on that computer, or a portion thereof, to another hard drive on the same computer. If a License Module accompanies, precedes, or follows this license, you may make and use that number of copies of the Software licensed to you by Symantec as provided in your License Module on an equal number of individual computers pursuant to the terms of this license. Your License Module shall constitute proof of your right to make and use such copies;

(ii) use the Software on that same computer to create an image file of a hard drive on that computer and store the image file on removable media for disaster recovery purposes;

(iii) use the Software to create a boot disk as described in the documentation for reapplying the hard drive image that was created for disaster recovery purposes to the hard drive on that same computer;

(iv) use the Software to clone a hard drive from that same computer to a replacement computer, in the manner described in the software documentation, and to use the Software on the replacement computer provided that the Software has been removed from the original computer;

(v) make one copy of the Software for archival purposes, or copy the Software onto the hard disk of your computer and retain the original for archival purposes;

(vi) use the Software on a network, provided that you have a licensed copy of the Software for each computer that can access the Software over that network;

(vii) after written notice to Symantec, transfer the Software on a permanent basis to another person or entity, provided that you retain no copies of the Software and the transferee agrees to the terms of this agreement.

You may not:

(i) use the Software commercially or non-commercially for the purpose of creating multiple computers or hard drives not connected to the original computer, with similar or identical configurations to that of the original computer or hard drive;

(ii) copy the documentation which accompanies the Software;

(iii) sublicense, rent or lease any portion of the Software;

(iv) reverse engineer, decompile, disassemble, modify, translate, make any attempt to discover the source code of the Software, or create derivative works from the Software; or

(v) use a previous version or copy of the Software after you have received a disk replacement set or an upgraded version as a replacement of the prior version. Upon upgrading the Software, all copies of the prior version must be destroyed.

Sixty Day Money Back Guarantee:

If you are the original licensee of this copy of the Software and are dissatisfied with it for any reason, you may return the complete product, together with your receipt, to Symantec or an authorized dealer, postage prepaid, for a full refund at any time during the sixty (60) day period following the delivery to you of the Software.

Limited Warranty:

Symantec warrants that the media on which the Software is distributed will be free from defects for a period of sixty (60) days from the date of delivery of the Software to you. Your sole remedy in the event of a breach of this warranty will be that Symantec will, at its option, replace any defective media returned to Symantec within the warranty period or refund the money you paid for the Software. Symantec does not warrant that the Software will meet your requirements or that operation of the Software will be uninterrupted or that the Software will be error-free.

THE ABOVE WARRANTY IS EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES, WHETHER EXPRESS OR IMPLIED, INCLUDING THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS. YOU MAY HAVE OTHER RIGHTS, WHICH VARY FROM STATE TO STATE.
Disclaimer of Damages:

REGARDLESS OF WHETHER ANY REMEDY SET FORTH HEREIN FAILS OF ITS ESSENTIAL PURPOSE, IN NO EVENT WILL SYMANTEC BE LIABLE TO YOU FOR ANY SPECIAL, CONSEQUENTIAL, INDIRECT OR SIMILAR DAMAGES, INCLUDING ANY LOST PROFITS OR LOST DATA ARISING OUT OF THE USE OR INABILITY TO USE THE SOFTWARE EVEN IF SYMANTEC HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

SOME STATES DO NOT ALLOW THE LIMITATION OR EXCLUSION OF LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.

IN NO CASE SHALL SYMANTEC'S LIABILITY EXCEED THE PURCHASE PRICE FOR THE SOFTWARE. The disclaimers and limitations set forth above will apply regardless of whether you accept the Software.

U.S. Government Restricted Rights:

RESTRICTED RIGHTS LEGEND. All Symantec products and documentation are commercial in nature. The software and software documentation are "Commercial Items", as that term is defined in 48 C.F.R. §2.101, consisting of "Commercial Computer Software" and "Commercial Computer Software Documentation", as such terms are defined in 48 C.F.R. §227.7202, as applicable. Consistent with 48 C.F.R. §12.212, 48 C.F.R. §227.7202, as applicable, Symantec's computer software and computer software documentation are licensed to United States Government end users with only those rights as granted to all other end users, according to the terms and conditions contained in this license agreement. Manufacturer is Symantec Corporation, 20330 Stevens Creek Blvd., Cupertino, CA 95014.

General:

This Agreement will be governed by the laws of the State of California. This Agreement may only be modified by a License Module which accompanies this license or by a written document which has been signed by both you and Symantec. Should you have any questions concerning this Agreement, or if you desire to contact Symantec for any reason, please write: Symantec Customer Sales and Service, 20330 Stevens Creek Blvd., Cupertino, CA 95014.
# CONTENTS

## Chapter 1  About Norton Ghost
- How Norton Ghost works ................................................................. 9
- What you can do with Norton Ghost ............................................ 10
  - Upgrade your hard drive .......................................................... 10
  - Back up and recover your computer ........................................ 10
  - Clone disks at optimum speed .................................................. 10
- Norton Ghost components ......................................................... 11
  - Ghost Boot Wizard ................................................................. 11
  - Norton Ghost executable .......................................................... 11
  - Ghost Explorer ........................................................................ 12
  - GDisk .................................................................................... 12

## Chapter 2  Installing Norton Ghost
- System requirements ......................................................................... 13
- Installing Norton Ghost ...................................................................... 14
- Updating Norton Ghost ...................................................................... 14
- Uninstalling Norton Ghost ............................................................... 14

## Chapter 3  Creating boot disks with the Ghost Boot Wizard
- Opening the Ghost Boot Wizard ..................................................... 15
- Creating boot disks and boot images ............................................... 16
  - Standard boot disks with the option of LPT and USB support .......... 16
  - Boot disks with network support .................................................. 18
  - Boot disks with CD-ROM support ............................................... 19
- Multicard templates and the boot disk .......................................... 20
- Adding network drivers to the Ghost Boot Wizard ......................... 20
  - Adding packet drivers to the Ghost Boot Wizard ......................... 21
  - Adding NDIS2 drivers to the Ghost Boot Wizard ......................... 22
  - Customizing the template .......................................................... 22
- Adding command-line parameters to a boot package ...................... 23
- Selecting a version of DOS ............................................................ 24
Chapter 4  Cloning disks and partitions

Starting the Norton Ghost executable ............................................... 25
Finding the Norton Ghost license number ........................................ 26
Navigating without a mouse ............................................................ 27
   Using Norton Ghost ..................................................................... 27
Cloning disks ................................................................................. 28
   Cloning disk to disk ............................................................... 28
   Cloning a disk to an image file ................................................ 29
   Cloning a disk from an image file ............................................ 31
Cloning partitions ........................................................................... 33
   Cloning from partition to partition ............................................ 33
   Cloning a partition to an image file ........................................... 34
   Cloning a partition from an image file ....................................... 36
Saving an image file to a CD-R/RW ................................................... 38
   Create Ghost boot disks .......................................................... 38
   Start your computer ................................................................ 38
   Create and save the image file ................................................ 39
Adding switches to your cloning task .............................................. 39

Chapter 5  Image file options

About Norton Ghost image files ...................................................... 41
Image files and compression ......................................................... 42
   Performance expectations on a network .................................... 42
Image files and CRC32 ................................................................. 43
Image files and volume spanning .................................................. 43
   Standard image files .............................................................. 43
   Size-limited, multisegment image files ..................................... 43
   Spanned image files .............................................................. 44
   Spanning across multiple volumes and limiting span sizes ...... 44
   Loading from a spanned image ............................................... 45
Image files and tape drives ............................................................ 45
Image files and CD writers ............................................................ 47
GoBack and Norton Ghost ............................................................. 49
Cloning dynamic disks in Windows 2000 ....................................... 50

Chapter 6  Using Ghost Explorer to modify image file contents

Viewing image files ......................................................................... 52
Restoring a file or directory from an image file ............................. 53
Chapter 7 Managing partitions using GDisk

Running GDisk .................................................. 58
Overview of main command-line switches .................................. 58
Online Help for command-line switches ................................... 59
Switches common to all GDisk commands .......................... 60
Creating a partition .................................................. 60
Reinitializing the Master Boot Record .................................. 62
Showing information about disks ........................................ 62
Performing multiple GDisk operations using batch mode .............. 63
FAT16 partitions in Windows NT ........................................... 65
Deleting and wiping your disk .............................................. 65
Activate or deactivate a partition ......................................... 67
Hide or unhide a partition .................................................. 67
Modify the Windows NT/2000 boot menu ................................. 68
  Specifying the boot.ini path and file name ..................... 68
  Displaying the list of current boot entries ..................... 68
  Adding an entry to Boot.ini ...................................... 69
  Adding an entry for starting Windows NT/2000 .......... 70
  Adding an entry for starting a non-Windows NT/2000
    operating system ............................................... 71
  Removing an entry from Boot.ini ................................. 72
Setting the default boot option and timeout .......................... 72
Support for large hard disks .......................................... 73

Appendix A Command-line switches

Clone switch syntax .................................................. 89
  Defining the type of clone command .............................. 89
  Cloning combination options .................................... 90
Setting a source for the clone switch ................................ 90
Setting a destination for the clone switch .......................... 91
Setting a destination size for the clone switch ..................... 92
Examples of clone switch usage .................................. 93
CRC32 switch usage ............................................... 94
  Examples of -CRC32 usage .................................. 95
Appendix B  Setting up the hardware and transfer methods

Peer-to-peer connections .......................................................... 99
  LPT or USB connections .......................................................... 100
  TCP/IP connections .............................................................. 100
SCSI tape driver ........................................................................ 100
Removable media ........................................................................ 101
CD-ROM usage .......................................................................... 101
Internal drives ........................................................................... 101
  Third party device ................................................................. 101

Appendix C  USB and DirectParallel Cables

Parallel Technologies cables ..................................................... 103
Other USB cables ...................................................................... 104

Appendix D  Cloning with Linux

Supported configurations .......................................................... 105
Position of disk .......................................................................... 106
Boot configuration ...................................................................... 106
Norton Ghost utility support ...................................................... 106

Appendix E  Troubleshooting

Appendix F  The Wattcp.cfg network configuration file

Appendix G  Diagnostics

Hard drive detection and diagnostic information ...................... 111
  Norton Ghost abort error file (Ghosterr.txt) ......................... 111
  Listing hard disk geometry diagnostics .............................. 112
  Creating a full diagnostic statistics dump summary .............. 112
Testing TCP/IP functionality .................................................... 112
  Pinging a local host .............................................................. 113

Service and support solutions

CD Replacement Form

Index
About Norton Ghost

Norton Ghost is a fast and reliable software solution to satisfy all of your computer disk cloning and copying needs. The high-performance utilities help you upgrade, back up, and recover entire disks or selected partitions. Norton Ghost can determine the partition sizes for the destination drive automatically. You can clone directly between two computers using a network, USB, or parallel connection. Designed for technically proficient users, Norton Ghost is based on Symantec Ghost Enterprise 7.0.

Norton Ghost includes the following features:

- **Fast performance**: Norton Ghost is based on Symantec Ghost Enterprise 7.0 with improved performance. You can clone and restore image files faster than ever.

- **File system support**: You can clone all FAT, NTFS, and EXT2 file systems. Norton Ghost also supports cloning of Windows 2000 and XP Home/Pro. You can now clone Linux EXT2 files larger than 4 GB.

- **Ability to write to a CD-R/RW**: You can write an image directly to a CD-R/RW and make the CD disk bootable.

- **Image file management**: You can modify image files by adding and deleting files.

- **Disk and partition management**: You can run GDisk from DOS or in a command shell from within Windows to manage partitions and disks.

How Norton Ghost works

The basis of Norton Ghost is a cloning function that creates an image file containing all of the information required to recreate a complete disk or partition. Image files create backup copies of complete drives or partitions. The image file is cloned onto one or more partitions or disks, replacing existing data.
What you can do with Norton Ghost

Using Norton Ghost cloning functionality you can perform upgrades of your hard drive, and backup and recover your computer fast and reliably.

Upgrade your hard drive

Use Norton Ghost to create a copy of your hard disk before upgrading to another one. Create an image file on removable media, or clone directly to another computer using a network, USB, or parallel connection. For even greater flexibility, Norton Ghost supports Linux EXT2, as well as Microsoft FAT and NTFS file systems. Norton Ghost determines the partition sizes for the destination drive automatically. Once the hard disk is installed, you can restore saved files by cloning the old hard disk onto the new hard disk, or restoring a saved image file.

Back up and recover your computer

Use Norton Ghost to create an image file of your computer on removable media, such as CD-R/RW, ZIP disks, and JAZ disks, and back up an entire hard disk or selected partitions. Use it for weekly backups or specific events, such as the installation of a new operating system. If you run out of space when backing up to a removable disk, Norton Ghost prompts you to insert another disk or save to an alternate location. Once an image is created, you can use Norton Ghost to restore the hard disk or any of the partitions saved.

Clone disks at optimum speed

Norton Ghost saves you time when:

- Copying one hard drive onto another
- Loading an image file from one hard drive to another when both drives are installed in the same computer

Many computers can transfer data at speeds of 1 gigabyte (GB) per minute. This is an astounding speed especially considering that an image of a drive containing a Windows 98 operating system is a few hundred megabytes in size. Using Norton Ghost to restore Windows 98 may take seconds.
Norton Ghost components

Norton Ghost includes a number of products and utilities that you can install.

Ghost Boot Wizard

The Ghost Boot Wizard creates boot disks that start Norton Ghost when you turn on your computer. You can create boot disks for various cloning tasks. The wizard guides you to the drivers needed to create a boot disk. The Ghost Boot Wizard is a Windows application.

Norton Ghost executable

The Norton Ghost executable makes disk cloning possible. Because the executable is small with minimal conventional memory requirements, it can be run easily from a DOS boot disk or hard drive. Norton Ghost can restore a computer from an image file containing both Windows 98 and the full installation of Office 97 in about five minutes.

Norton Ghost can make complete backups of disks or partitions, copying system files that other backup utilities miss. This makes it a useful tool for disaster recovery operations.
Ghost Explorer

Ghost Explorer is a Windows application that lets you view directories and files in an image file, and then add, recover, and delete individual directories and files from an image file.

GDisk

GDisk is a complete replacement for the FDISK and FORMAT utilities that allows:

- FAT file system formatting
- Better disk space utilization
- Batch mode operation
- Hiding and unhiding of partitions
- Secure disk wiping
- Extensive partition reporting

Two versions of GDisk are supplied.

- GDisk: Runs in DOS
- GDisk32: Runs from the command-line in a Windows operating system
Installing Norton Ghost

The Norton Ghost CD includes Norton Ghost, Ghost Explorer, and the Ghost Boot Wizard.

System requirements

To use Norton Ghost, your computer must meet the following minimum requirements:

- IBM computer or 100% compatible
- 386 processor
- 8 MB RAM
- VGA monitor, resolution 640 x 480
- Microsoft compatible mouse recommended

To install Norton Ghost and to run Ghost Explorer and the Ghost Boot Wizard the minimum software requirements are:

- Windows 98, NT 4.0, 2000, XP, or Me
- Internet Explorer 4

File systems supported for standalone cloning are:

- All FAT
- All NTFS
- EXT2

For more information, see “Cloning with Linux” on page 105.
Installing Norton Ghost

The Norton Ghost executable runs under DOS, but you must install Norton Ghost in a Windows operating system.

**To install Norton Ghost**

1. Insert the Norton Ghost CD into the CD-ROM drive.
2. In the Norton Ghost install window, click *Install Norton Ghost 2002*.
3. Click *Next*.
4. Follow the on-screen instructions.

Updating Norton Ghost

LiveUpdate provides Norton Ghost with updates. It connects to Symantec sites to provide free updates to fix defects and provide additional features to the Norton Ghost program. LiveUpdate connects to Symantec via the Internet to see if updates are available for Norton Ghost.

Symantec does not charge for Norton Ghost updates. However, your normal Internet access fees apply.

**To update Norton Ghost using LiveUpdate**

2. On the Help menu, click *LiveUpdate*.
3. Follow the on-screen instructions.

Uninstalling Norton Ghost

Norton Ghost is uninstalled from the Control Panel in Windows.

**To uninstall Norton Ghost**

1. On the Windows taskbar, click *Start > Settings > Control Panel*.
2. Double-click *Add/Remove Programs*.
3. Click *Norton Ghost 2002*.
4. Click *OK*. 
CHAPTER 3

Creating boot disks with the Ghost Boot Wizard

The Ghost Boot Wizard creates boot packages that let you complete a number of different cloning tasks. For any given task, the Ghost Boot Wizard guides you through the different steps to select the settings and drivers needed to create the boot package.

Opening the Ghost Boot Wizard

The procedures in this chapter assume that you know how to open the Ghost Boot Wizard.

To open the Ghost Boot Wizard

Creating boot disks and boot images

The processes for creating boot images and disks include how to create:

- Standard boot disks that enable the use of Norton Ghost on a single computer
- Boot disks enabling peer-to-peer services for USB and LPT
- Network boot disks with network support for TCP peer-to-peer connections
- CD-ROM boot disks with generic CD-ROM drivers for reading a Ghost image from a CD-ROM
- A disk used in the creation of a bootable CD-ROM

Standard boot disks with the option of LPT and USB support

The Ghost Boot Wizard creates a boot disk that does one of the following:

- Lets you write Ghost images to a CD-R/RW
- Runs Ghostpe.exe on computers with LPT and USB support
- Contains Ghostpe.exe only

Note: Norton Ghost does not support writing to a CD-ROM drive that is connected with a USB cable.

The default mode is ECP/EPP High Speed. If you are having problems with your LPT connection, set the mode to Bidirectional 8bit or Bidirectional 4bit. The next time you create a boot disk, the mode is reset to the default ECP/EPP High Speed.

If you have multiple parallel ports and want to connect via any port other than the default LPT1, use the LPT port option to specify the port into which your cable is plugged. If you cannot get a connection with the default LPT port, you can connect to a specific port.
Creating boot disks and boot images

To create a standard boot disk, or with support for LPT and USB cables

1. In the Ghost Boot Wizard window, click **Boot Disk with CD-R/RW, LPT and USB Support**.

2. Click **Next**.

3. Do one or more of the following:
   - Check **USB support** to add USB support to the boot disk.
   - Check **LPT support** to add LPT support to the boot disk.
   - Uncheck to clear **USB support** and **LPT support** to create a boot disk that runs Norton Ghost on a single computer.
   - Click **Advanced** to change the LPT mode or port.
   - Click **Include Adaptec SCSI drivers** to add drivers to support Adaptec SCSI drivers to the boot disk.
     These drivers are required to write an image directly to a SCSI CDR that is supported by Norton Ghost.

4. Click **Next**.

5. Select one of the following:
   - Use PC-DOS: Include PC-DOS on the boot disk.
   - Use MS-DOS: Include MS-DOS on the boot disk.

   For more information, see “Selecting a version of DOS” on page 24.

6. Click **Next**.

7. Type the correct path in the GhostPE.exe field, if the executable has been moved or you want to use a different version of Norton Ghost.
   The default path to the Norton Ghost executable appears in the GhostPE.exe field.

8. In the Parameters field, type any required command-line parameters.
   For more information, see “Adding command-line parameters to a boot package” on page 23.

9. Click **Next**.

10. In the Floppy Disk Drive field, type the appropriate drive letter.

11. In the Number of disks to create field, type the number of disks that you want to create.

12. Click **Format disk(s) first** to format the disks before disk creation.

13. Click **Quick Format** to perform a quick format.

14. Click **Next**.
Boot disks with network support

The Ghost Boot Wizard helps you create boot disks that provide network support for TCP/IP peer-to-peer connections.

Before starting this process, you need to know the types of network cards that are installed on your computers. Unless you use the multicard template, you must create a boot disk for each network card.

To create a boot disk with network support

1. In the Ghost Boot Wizard window, click Peer-to-Peer Network Boot Disk.
2. Click Next.
3. Select the network driver for the make and model of the network card installed on the computer.
   If the correct driver isn’t in the list, add the driver.
   For more information, see “Adding network drivers to the Ghost Boot Wizard” on page 20 and “Multicard templates and the boot disk” on page 20.
4. Click Next.
5. Select one of the following:
   - Use PC-DOS: Include PC-DOS on the boot disk.
   - Use MS-DOS: Include MS-DOS on the boot disk.
   For more information, see “Selecting a version of DOS” on page 24.
6. Type the correct path in the GhostPE.exe field if the executable has been moved, or you want to use a different version of Ghost.
   The default path to the Ghost executable is in the GhostPE.exe field.
7. In the Parameters field, type any required command-line parameters.
   For more information, see “Adding command-line parameters to a boot package” on page 23.
8. Click Next.
9. Do one of the following:
   - Click DHCP will assign the IP settings if your network contains a DHCP server.
   - Click The IP settings will be statically defined and complete the fields below this option if your network does not contain a DHCP server.
10 Click **Next**.
11 In the Floppy Disk Drive field, type the appropriate drive letter.
12 In the Number of disks to create field, type the number of disks that you want to create.
13 Click **Format disk(s) first** to format the disks before disk creation.
14 Click **Quick Format** to perform a quick format.
15 Click **Next**.

**Boot disks with CD-ROM support**

Boot disks with CD-ROM support let you access images stored on CD-ROM.

**To create a boot disk with CD-ROM support**

1 In the Ghost Boot Wizard window, click **CD-ROM Boot Disk**.
2 Click **Next**.
3 Select one of the following:
   - Use PC-DOS: Include PC-DOS on the boot disk.
   - Use MS-DOS: Include MS-DOS on the boot disk.
   For more information, see “Selecting a version of DOS” on page 24.
4 Click **Next**.
5 Type the correct path in the GhostPE.exe field, if the executable has been moved, or you want to use a different version of Ghost.
   The default path to the Ghost executable appears in the GhostPE.exe field.
6 In the Parameters field, type any required command-line parameters.
   For more information, see “Adding command-line parameters to a boot package” on page 23.
7 Click **Next**.
8 In the Floppy Disk Drive field, type the appropriate drive letter.
9 In the Number of disks to create field, type the number of disks that you want to create.
10 Click **Format disk(s) first** to format the disks before disk creation.
11 Click **Quick Format** to perform a quick format.
12 Click **Next**.
Multicard templates and the boot disk

You can use multicard templates to create a boot disk containing several NDIS2 drivers. When the computer starts, a special multicard driver checks the computer’s hardware to see if any of the NDIS2 drivers can be used to access the installed network card.

Refer to the Software License Agreement for use restrictions.

To create a multicard template
1. In the Network Interface Card window, click Multicard Template.
2. Click Next.
3. Select the required drivers from the list of NDIS2 drivers.
   Select no more than five drivers as space is limited on a floppy disk.
4. Click Next.

Adding network drivers to the Ghost Boot Wizard

The Ghost Boot Wizard includes drivers to over 80 network interface cards. If your driver isn’t in the list, you can add it to the wizard so that it’s set up the next time you need it.

To begin adding a network driver to the Ghost Boot Wizard
1. In the Network Interface Card window, click Add.
2. Select one of the following:
   - Packet Driver
   - NDIS2 Driver
   Many manufacturers ship both drivers with their network cards so you have a choice of which one to use.
3. Click OK.
Adding packet drivers to the Ghost Boot Wizard

Packet drivers are usually DOS executables (with .com or .exe file extensions) that load from the Autoexec.bat file before Norton Ghost loads. Norton Ghost communicates directly with the packet driver to use the services provided by the network card.

To add a packet driver to the Ghost Boot Wizard

1. In the Template Properties window, on the Packet Driver tab, in the Driver Executable field, type the packet driver location so that the Ghost Boot Wizard can copy the file to the current template.
   
   Packet drivers are usually included on the driver disk supplied with the network card. If you are installing the packet driver from the original disks that came with your network interface card, the packet driver should be in a directory called Packet or Pktdrv.

2. In the Parameters field, type the command-line parameters if the network card requires them.
   
   These parameters vary from driver to driver and are usually optional with plug-and-play network cards. Consult the documentation that came with the network card. This is often in the form of a Readme.txt file in the same directory as the driver itself.

3. Click Select Automatically to let Ghost determine the best multicasting mode based on the information in the packet driver.
   
   If the Select Automatically mode does not work, try Receive Mode 5. If that doesn’t work, try Receive Mode 6.
   
   Although Norton Ghost does not support the multicasting of Ghost images, it is necessary to set a multicasting mode.
**Adding NDIS2 drivers to the Ghost Boot Wizard**

NDIS2 drivers work with the Microsoft Network Client. NDIS2 drivers are DOS drivers that load from the DOS Config.sys file.

**To add an NDIS2 driver to the Ghost Boot Wizard**

1. In the Template Properties window on the NDIS Driver tab, click **Setup**.

2. Locate the NDIS2 driver.
   - In many cases Ghost can automatically determine the other parameters for your network. When locating the directory that contains the driver, look for a folder named Ndis or Ndis2. If you have a choice between DOS and OS2 folders, select DOS.

3. Type the DOS file name for the NDIS2 driver.

4. In the Driver Name field, type the internal name of the driver.
   - The internal name of the driver is used when generating the Protocol.ini configuration file and must always end with a $ character. If the Setup did not fill in this field for you, read the sample Protocol.ini file in the same directory as the driver itself to find the driver name.

5. In the Parameters field, type the parameters for the Protocol.ini configuration file.
   - If you use Setup to automatically fill in this page, you will see the parameters that you need to adjust. For the majority of plug-and-play cards, all of the parameters are optional, so you can either accept the defaults or leave this field empty.

**Customizing the template**

You may require additional drivers and programs in order to use the network device attached to your computer. For example, many USB network devices need to load an extra driver for the USB port before the driver for the network device.

You can add files to the template and customize the Autoexec.bat and Config.sys files of the resulting boot disk. Usually these are either DOS drivers or executable programs, but any type of file can be added. Files added to the template appear in the list to the right of the button.

If this template is a multicard template then any additional files or modifications are overridden by the settings in the multicard template.
To add a file to a template

1. In the Template Properties window, on the Advanced tab, click **New**.
2. Click **Delete** to delete the selected file from the list.
3. In the Autoexec.bat field, type any additional Autoexec.bat entries for the driver.
   The entries appear before any network-related commands, such as Netbind.com or the packet driver executable.
4. In the Config.sys field, type any additional Config.sys entries for the driver.
   The entries appear before any driver-related devices load to ensure that enabling drivers load before the main network device drivers specified on the network driver page.

### Adding command-line parameters to a boot package

You can enter command-line parameters to a boot package to instruct Norton Ghost to perform certain actions.

For more information, see “**Command-line switches**” on page 75.

In the following example, the parameters instruct Norton Ghost to back up your main disk to an image on another drive.

```plaintext
-clone,mode=dump,src=1,dst=d:\backups\maindrv.gho
```

<table>
<thead>
<tr>
<th>Clone Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>mode=dump</td>
<td>Dumps an image.</td>
</tr>
<tr>
<td>src=1</td>
<td>Specifies drive 1 as the source drive.</td>
</tr>
<tr>
<td>dst=D:\Backups\Maindrv.gho</td>
<td>Saves the image to the file D:\Backups\Maindrv.gho</td>
</tr>
</tbody>
</table>
Selecting a version of DOS

The Ghost Boot Wizard includes IBM PC-DOS on a boot disk. However, a boot disk that includes IBM PC-DOS might not start on all computers. When creating a boot disk, you can include MS-DOS instead of IBM PC-DOS.

If you use MS-DOS, then you must install MS-DOS files on the computer on which you are creating the boot disk. Using a floppy disk that was formatted on a Windows 9x computer, you can install the MS-DOS files during the creation of the boot disk.

To install MS-DOS files on your computer

1. Insert a blank floppy disk into drive A of a Windows 9x computer.
2. Double-click the My Computer icon.
3. Right-click drive A then click Format.
4. Click Copy System Files.
5. Insert the formatted floppy disk into drive A of the computer on which the Ghost Boot Wizard is running.
6. In the Ghost Boot Wizard, in the DOS version window, click Get MS-DOS.
You can use the Norton Ghost executable to clone a computer, create a backup, and restore a computer. You can write an image file directly to a CD-R/RW and make the disk bootable. You can add some command-line switches to the cloning task in the Options window.

Starting the Norton Ghost executable

The Norton Ghost executable is a DOS-based application and should run in DOS mode outside of Windows. If you run the Norton Ghost executable (Ghostpe.exe) within Windows 98, note the following:

- Files may be in an open or changing state. If these files are cloned, the resulting destination files are left in an inconsistent state.
- The partition on which Windows 98 is installed must not be overwritten.
- If you overwrite a drive or partition, the system must be restarted.
- Norton Ghost does not automatically restart the system.
- Hard disk sizes may appear smaller than their actual sizes. The Norton Ghost executable can only access the shown destination size. The remaining space is not used.
- The Norton Ghost executable fails if you try to overwrite any of the following:
  - Windows swap files
  - Registry files
  - Open files
You cannot run Norton Ghost within Windows NT, Windows 2000, Linux, OS/2, or other nonDOS operating systems. To run Norton Ghost on a computer running a nonDOS operating system, use a Ghost boot disk.

To start the Norton Ghost executable

- Do one of the following:
  - Start the computer using a Ghost Boot Disk. For more information, see “Creating boot disks and boot images” on page 16.
  - For Windows 98 computers, start the computer in DOS. At the DOS prompt, type:

    \C:\Program Files\Norton Ghost\ghostpe.exe

    Running Norton Ghost in DOS may require additional DOS drivers to let Norton Ghost access and use some hardware.

Finding the Norton Ghost license number

The Norton Ghost license number is entered when you dump an image file to a computer. The license number for your copy of Norton Ghost is displayed each time you start Norton Ghost.

To find the license number for Norton Ghost

- Start Norton Ghost.

The license number is displayed on the splash screen in the License Number field.
Navigating without a mouse

If you have mouse drivers loaded, you can use the mouse to navigate in Norton Ghost. You can also use the keyboard.

- Use arrow keys to navigate the menu.
- Press Tab to move from button to button.
- Press Enter to activate the selected button.
- Press Enter to select an item in a list.

Using Norton Ghost

To use Norton Ghost

1. Start the Norton Ghost executable.
2. Add command-line switches, if necessary.
   For more information, see “Command-line switches” on page 75.
3. Select the transfer method.
4. Select the Norton Ghost operation.
5. Do one of the following:
   - Select the source hard drive and partitions.
   - Select the image file.
6. Do one of the following:
   - Select the destination hard drive and partition.
   - Select the image file.
   Make sure that you select the correct destination to overwrite. In most cases, you cannot recover data from an incorrectly selected destination drive.
7. Complete the cloning operation.
Cloning disks and partitions

Cloning disks

You access disk cloning procedures from the main menu. You can specify one of the following transfer methods:

- Local
- LPT > Master
- USB > Master
- TCP/IP > Master

By default Norton Ghost tries to maintain the same size ratio between the new disk partitions. However, you should note the following:

- You can change the size of any destination FAT, NTFS, or Linux Ext2 partition by entering the new size in megabytes.
- You cannot enter a value that exceeds the available space, is beyond the file system’s limitations, or that is not large enough to contain the data held in the source partition.

Cloning disk to disk

When you clone disk to disk, Norton Ghost copies the contents of one hard disk onto another.

To clone disk to disk

1. On the Norton Ghost main menu, click Local > Disk > To Disk.
2. In the License field, type your license number.
3. Click OK.
4. In the Source Drive dialog box, select the source drive.
   The Source Drive dialog box shows the details of every disk that Norton Ghost finds on the local computer.
5. In the Destination Drive dialog box, select the destination drive.
   Choose carefully as this is the disk that will be overwritten.
   If a peer-to-peer connection method is used, the destination drive will be any of the slave computer’s disks. However, if this is a local disk-to-disk copy, then the source disk is unavailable for selection.
6. Confirm or change the destination drive partition layout.
   The Destination Drive Details dialog box shows a suggested partition layout for the destination drive.
7 Click OK.

8 When the “ Proceed with Disk Clone?” question appears, check the details and ensure that the correct options are selected.

9 Do one of the following:
   - Click Yes to proceed with the disk cloning.
     The system performs an integrity check of the file structure on the source disk, and then copies the source disk to the destination. If you need to abort the process press Ctrl-C, but be aware that this leaves the destination disk in an unknown state.

   Warning: Only click Yes if you are sure that you want to proceed. The destination drive is overwritten with no chance of recovering any data.

   - Click No to return to the menu.

10 Restart the computer.

   Warning: You should remove the second hard drive before you restart your computer. If you leave the second drive in the computer, damage can occur to both of the bootable operating systems.

11 Run Symantec Disk Doctor, ScanDisk, or a similar utility to verify the integrity of the destination disk.

Cloning a disk to an image file

You can copy an image file to another disk or use the image file as a backup file.

When using peer-to-peer connections, the image file is created on the slave computer.

If you write the image file to a CD, write to a bootable CD. If a boot disk is placed in the floppy drive before the cloning session begins, Norton Ghost copies the system files from the boot disk onto the CD.
To clone a disk to an image file

1. On the Norton Ghost main menu, click **Local > Disk > To Image**.
2. In the Source Drive dialog box, select the source drive.
   The Source Drive dialog box shows details of every disk that Norton Ghost finds on the local computer.
3. In the File Locator dialog box, type the image file destination and name.
   The image file may reside on a local drive (but not the one from which it is being copied). Local drives include writable CD, tape, ZIP, JAZ, and LS120 Superdisk drives.
4. In the Image file description dialog box, type a description of the image file.
   You can modify this description in Ghost Explorer.
5. Click **Save**.
6. When the “Compress Image File?” question appears, do one of the following:
   - Click **No** for no compression (high speed).
   - Click **Fast** for low compression (medium speed).
   - Click **High** for high compression (slower speed).
   For more information, see “Image files and compression” on page 42.
Cloning disks

7 If spanning is enabled, click Yes and type the location of the next span of the image file.
For more information, see “Image files and volume spanning” on page 43.

8 When the “Proceed with Image File Creation?” question appears, check the details and ensure that the correct options have been selected.

9 Do one of the following:
   ■ Click Yes to proceed with the image file creation.
   The system performs an integrity check of the file structure on the source disk and then copies the source disk to the destination image file. If you need to abort the process, press Ctrl-C, but be aware that this leaves the destination image file in an unknown state.
   ■ Click No to return to the menu.

10 On the main menu, click Check > Image File to verify the integrity of the image file.

Cloning a disk from an image file

You can load a copy of one disk to another disk using a previously created image file.

To clone a disk from an image file
1 On the main menu, click Local > Disk > From Image.
2 In the File Locator dialog box, do one of the following:
   ■ Type the path and file name of the image file.
   ■ Click Browse to locate the image file.
3 Select the drive or device.
4 Select the full path name.
   The image file may reside on a local drive (but not the one to which it is being copied). When using peer-to-peer connections, the file is located on the slave computer.
5 Press Enter.
6 In the License field, type your license number.
7 Click OK.
Cloning disks and partitions

8 In the Destination Drive dialog box, select the destination drive. Choose carefully as this is the disk that will be overwritten.

The Destination Drive dialog box shows the details of every drive that Norton Ghost finds on the local computer. If you are copying from the local computer, the disk containing the source image file is not available for selection.

9 In the Destination Drive Details dialog box, confirm or change the destination drive partition layout.

The Destination Drive Details dialog box shows a suggested partition layout for the destination drive. By default, Norton Ghost tries to maintain the same size ratio between the new disk partitions. However, you should note the following:

- You can change the size of any target FAT, NTFS, or Linux Ext2 partition by entering the new size in megabytes.
- You cannot enter a value that exceeds the available space, is beyond the file system’s limitations, or is not large enough to contain the data held in the source partition.

10 Click OK.

11 Do one of the following:

- Click Yes to proceed with the disk cloning.

  Norton Ghost creates the destination drive using the source image file drive details. If you need to abort the process, press Ctrl-C, but be aware that this leaves the destination drive in an unknown state.

  **Warning:** Only click Yes if you are sure that you want to proceed. The destination drive is completely overwritten with no chance of recovering any data.

- Click No to return to the menu.

12 If spanning is enabled, do one of the following:

- Click OK to continue on the same form of media.
- Click Filename to restore from a different location, then type the location and file name of the image file span.

13 Restart the computer when the disk image load is complete.

Run Symantec Disk Doctor, ScanDisk, or a similar utility to verify the integrity of the destination drive.
Cloning partitions

You access partition cloning procedures from the main menu. You can select to transfer with one of the following methods:

- Local
- LPT > Master
- USB > Master
- TCP/IP > Master

Cloning from partition to partition

You can directly clone from one partition to another.

To clone from partition to partition
1. On the main menu, click Local > Partition > To Partition.
2. In the License field, type your license number.
3. Click OK.
4. In the Source Drive dialog box, select the source drive.
   The Source Drive dialog box shows details of every drive that Norton Ghost finds on the local computer.
5. In the Source Partition dialog box, select the source partition.
   The Source Partition dialog box shows the details of all of the partitions on the selected source drive.
6. In the Destination Drive dialog box, select the destination drive.
   The Destination Drive dialog box shows the details of every disk that Norton Ghost finds on the destination computer. For peer-to-peer connections, the slave computer is the destination.
7. In the Destination Partition dialog box, select the destination partition.
   Select an existing partition carefully as this is the partition that is overwritten.
   The Destination Partition dialog box shows the details of all of the partitions on the selected destination drive. If this is a local partition-to-partition copy, then the source partition is unavailable for selection. However, you can create a new partition if space is available. If you create a new partition, it can be resized during the cloning operation.
8. Click OK.
Cloning disks and partitions

9 When the final “Proceed with Partition Copy?” question appears, ensure that the correct options have been selected. This is the last chance to back out.

10 Do one of the following:

- Click **Yes** to proceed with the partition copy.
  
  If you need to abort the process, press **Ctrl-C**, but be aware that this leaves the destination drive in an unknown state.

  **Warning:** Only click **Yes** if you are sure that you want to proceed. The destination partition is completely overwritten with no chance of recovering any data.

- Click **No** to return to the menu.

11 Restart the destination computer when the partition copy is complete.

Run Symantec Disk Doctor, ScanDisk, or a similar utility to verify the integrity of the destination partition.

**Cloning a partition to an image file**

You can create an image file from a partition to use as a backup, or to clone onto another partition.

The image file may reside on a local drive (but not the one from which it is being copied). Local drives include writable CD, tape, ZIP, JAZ, and LS120 Superdisk drives.

When using peer-to-peer connections, the image file is created on the slave computer.

If you write the image file to a CD, write to a bootable CD. If a boot disk is placed in the floppy drive before the cloning session begins, Norton Ghost copies the system files from the boot disk onto the CD.

Compression may affect the speed of operations. When you select a compression level, Norton Ghost estimates the amount of space available for the destination image file. If there is insufficient space, Norton Ghost prompts you to enable spanning of image files.
To clone a partition to an image file

1. On the main menu, click **Local > Partition > To Image**.

2. In the Source Drive dialog box, select the source drive.
   The Source Drive dialog box contains the details of every disk that Norton Ghost finds on the local computer.

3. In the Source Partition dialog box, select the source partitions to include in the destination image file.
   The Source Partition dialog box contains the details of all the partitions on the selected source drive. Multiple partitions may be selected.

4. Click **OK**.

5. In the File Locator dialog box, select the image file.

6. Do one of the following:
   - Type the path and file name for the disk image file.
   - Click **Browse** to locate the image file.

7. Press **Enter**.

8. In the Compress Image? dialog box, do one of the following:
   - Click **No** for no compression (high speed).
   - Click **Fast** for low compression (medium speed).
   - Click **High** for high compression (slower speed).

9. If spanning is enabled, click **Yes** and type the location of the next span of the image file.
   For more information, see “Image files and volume spanning” on page 43.

10. In the Proceed with Partition Dump? dialog box, ensure that the correct options have been selected.
Cloning disks and partitions

11 Do one of the following:
   ■ Click **Yes** to proceed with the image file creation.
      The system performs a quick integrity check of the file structure on
      the source partitions and then copies the source partitions to the
destination image file. If you need to abort the process, press
      **Ctrl-C**, but be aware that this leaves the destination image file in an
      unknown state.
   ■ Click **No** to return to the menu.

12 On the main menu, click **Check > Image File**.
   After the image file has been created, Norton Ghost can verify the
   integrity of the image file.

Cloning a partition from an image file

Once you have created an image file from a partition, you can clone a
partition onto a partition on another computer with the image file.

**To clone a partition from an image file**

1 On the main menu, click **Local > Partition > From Image**.

2 In the File Locator dialog box, do one of the following:
   ■ Type the path and file name of the image file.
   ■ Click **Browse** to locate the image file.
      Specify the drive or device and select the full path name. The image
      file may reside on a local drive. When using peer-to-peer connections,
      the image file is located on the slave computer.

3 Press **Enter**.

4 In the Source Partition dialog box, select the source partition for the
   image file.
   The Source Partition dialog box contains the details of all of the
   partitions in the image file.

5 In the License field, type your license number.

6 In the Destination Drive dialog box, select the destination drive.
   The Destination Drive dialog box contains the details of every disk that
   Norton Ghost finds on the local computer.
7 In the Destination Partition dialog box, select the destination partition. Select an existing partition carefully as this is the partition that will be overwritten.

The Destination Partition dialog box contains the details of all of the partitions on the selected destination drive. If this is a local partition-to-partition copy, then the source partition is unavailable for selection. However, you can create a new partition if space is available. If you create a new partition, it can be resized during the cloning operation.

8 In the Proceed with Partition Load? dialog box, ensure that the correct options have been selected.

9 Do one of the following:
   - Click Yes to proceed with the partition cloning.
     Norton Ghost overwrites the destination partition using the partition details contained in the image file. If you need to abort the process, press Ctrl-C, but be aware that this leaves the destination partition in an unknown state.

**Warning**: Only click Yes if you are sure that you want to proceed. The destination partition is completely overwritten with no chance of recovering any data.

   - Click No to return to the menu.

10 If spanning is enabled do one of the following:
   - Click OK to continue on the same form of media.
   - Click Filename to restore from a different location, then type the location and file name of the image file span.

11 Restart the destination computer when the partition copy is complete. Run Symantec Disk Doctor, ScanDisk, or a similar utility to verify the integrity of the destination partition.
Saving an image file to a CD-R/RW

You can save an image file directly to a CD-R or CD-RW. You can also make the CD bootable.

For more information, see “Image files and CD writers” on page 47.

To save an image file to a bootable CD-R/RW, you must do the following:

- Create Ghost boot disks.
- Start your computer.
- Create and save the image file.

When writing an image file directly to a CD-R/RW, note the following:

- The CD-R/RW drive must be compatible with Norton Ghost.
  For more information, see “Image files and CD writers” on page 47.
- Norton Ghost automatically spans CD-R/RW disks if necessary. You do not need to use a spanning switch on the command-line.

Create Ghost boot disks

To write an image file directly to a CD, you must have a boot disk with which to start the computer. In the Ghost Boot Wizard, create a boot disk, using the Boot Disk with CD-R/RW, LPT and USB Support option. This creates a boot disk that contains the Ghost executable and DOS system files.

For more information, see “Standard boot disks with the option of LPT and USB support” on page 16.

To make the CD bootable, you must have a second boot disk. This boot disk is created in the Ghost Boot Wizard, using the CD-ROM Boot Disk option. This option creates a boot disk that contains the CD-R/RW driver files.

For more information, see “Boot disks with CD-ROM support” on page 19.

Start your computer

Insert the first boot disk you created into the computer’s floppy disk drive and restart the computer.
Create and save the image file

Create an image of the computer, choosing the CD-R/RW drive as the destination drive.

For more information, see “Cloning a disk to an image file” on page 29.

Norton Ghost lets you make the CD bootable during the creation of the image file. To make the CD bootable, follow the on-screen instructions. When prompted for the required files, insert the second boot disk that you created using the Ghost Boot Wizard into the computer's floppy disk drive.

Adding switches to your cloning task

When defining a cloning task, you can include a number of options (or switches) that are usually entered via the command-line.

**To add switches to your cloning task**

1. On the main menu, click **Options**.
2. On the tabs, select the options to include in your current cloning task:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Command-line options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Span/CRC</td>
<td>-span, -auto, -cns, -crcignore, -fcr</td>
</tr>
<tr>
<td>FAT 32/64</td>
<td>-f32, -f64, -fatlimit</td>
</tr>
<tr>
<td>Misc</td>
<td>-fro, -rb, -fx</td>
</tr>
<tr>
<td>Image/Tape</td>
<td>-ia, -ib, -id</td>
</tr>
<tr>
<td></td>
<td>-tapebuffered, plus options to: make safe, unbuffer, and eject the tape</td>
</tr>
<tr>
<td>HDD access</td>
<td>-ffx, -fnx, -ffi, -fni, -ffs, -fns</td>
</tr>
<tr>
<td>Security</td>
<td>-pwd, -locktype=type</td>
</tr>
</tbody>
</table>

For more information, see “Command-line switches” on page 75.

3. On the Save Settings tab, click **Save Settings** to confirm the list of active switches listed.
4. Click **Accept** to include the settings in the current task.
Image file options

Image file options include compressing an image file, using CRC32 to check the image file once it is created, and spanning an image across a number of image files. You can also write an image file to a tape or CD. This chapter contains information relevant to cloning with the utility GoBack installed and cloning dynamic disks.

About Norton Ghost image files

The image files created with Norton Ghost have a .gho extension by default. They contain the entire disk or partitions of the disk. Image files support:

- Various levels of compression
- CRC32 data integrity checking
- Splitting of media files
- Spanning across volumes

Norton Ghost images contain only the actual data on a disk. If you have a 9 GB drive with only 600 MB of data, the Norton Ghost image is approximately 600 MB, or smaller if you use compression.

If you also use the Ghost Explorer application, an image file companion utility, individual files from these image files are recovered selectively without having to restore the complete partition or disk.
Image file options

Image files and compression

Image files created in Norton Ghost support several levels of data compression. When using Norton Ghost in interactive mode, three compression options are provided: none, fast, and high. The Norton Ghost command-line switch, -z, provides access to nine levels of compression.

For more information, see “Command-line switches” on page 75.

As a rule, the more compression you use, the slower Norton Ghost operates. However, compression can improve speed when there is a data transfer bottleneck. There is a big difference in speed between high compression and no compression when creating an image file on a local disk. Over a network connection, fast compression is often as fast as, or faster than, no compression. Over a parallel cable, high compression is often faster than no compression because fewer bytes are sent over the cable. Decompression of high-compressed images is much faster than the original compression. The level of compression that you select depends on your own individual requirements.

Performance expectations on a network

One advantage of Norton Ghost is speed. It takes minutes to install an operating system such as Windows 98, whether onto 10 or 100 computers. Many factors affect performance. There are ways to gauge whether Norton Ghost is running optimally.

When using Norton Ghost on a network, use the fast compression option. If disk space is at a premium, you can use higher compression, but it affects speed.

Using a 10 MB/s ethernet network, a 25-60 MB/minute server speed is common. Factors influencing this range are:

- Using up-to-date drivers
- LAN traffic
- Choice of network hubs or switches, including brand and model
- Compression

On a 100 MB/s ethernet network, it is possible to achieve 80-300 MB/minute under ideal conditions. This speed is influenced by computer hardware and LAN performance. Greater performance is achieved with state-of-the-art computers, NICs, and hard disks.
Image files and CRC32

Cyclic Redundancy Checking (CRC) is a data error checking technique. CRC ensures that the original data written to the image file is the same as the data in the image file. The 32 value in CRC32 indicates that the CRC technique uses a 32-bit value to store error checking information. The use of CRC32 increases detection of errors in the image file.

When image files are created, CRC32 details are embedded into the file to ensure that image file corruption is detected when it is being loaded to disk. CRC32 is currently included on a file-by-file basis with FAT and Linux Ext2 partitions, and on an MFT table basis for NTFS partitions.

In addition to image file error detection, the CRC values are used to verify that image files and partitions or disks are identical. This offers an additional detection method against bad sector writes and other drive anomalies that may be missed during normal imaging checks.

A text file containing CRC values and associated file attributes can be generated using the -CRC32 command-line switch.

For more information, see “Command-line switches” on page 75.

Image files and volume spanning

Images can be contained in a single file or spanned across a number of files.

Standard image files

Standard image files consist of a single file containing the contents of the complete disk or required partitions. This type of image file is used for storing system configurations on other hard drives and tape drives where the volume is large enough to hold the complete image file.

Size-limited, multisegment image files

There are situations in which it is not practical to have a standard image file. Norton Ghost can split an image file into segments (known as spans) that are limited to a user-specified size. This option is most commonly used to limit span sizes to 550 MB for later transfer onto CD-ROM. The default (and maximum) file size is 2 GB.
Spanned image files

Spanned image files are similar to size-limited, multisegment image files. The difference is that each segment file (or span) of the image file is limited by the actual volume size of the media to which the image is being saved. This lets you specify a drive and file name and lets Norton Ghost sort out when to request another volume or location for the remaining data. This is very useful when using ZIP, JAZ, LS120 Superdisk, CD-R/RW drives, and other drive types.

Spanning must be executed locally. If you try to span over a peer-to-peer connection (LPT, USB, TCP/IP), a disk full error message appears. However, splitting can be used in all situations.

Norton Ghost also allows size limiting of spans when spanning volumes to ensure that no span exceeds the maximum size.

With all image files, the only constraint on the selection of the destination volume is that it must not be part of the source selection. For example, it cannot be on a source disk or partition if that disk or partition is to be included in the image.

Spanning across multiple volumes and limiting span sizes

When creating an image file from a disk or partition, the destination drive might have insufficient space to store the image file. If Norton Ghost determines that this is the case, it alerts you and asks whether to enable spanning. Norton Ghost assumes that compression reduces the size of the image by one-third when determining whether the image will fit. Alternatively, you can use the -span and -split command-line switches to configure Norton Ghost to use image file splitting.

For more information, see “Command-line switches” on page 75.

Before saving the disk contents to the image file, Norton Ghost shows the source and destination details and offers a chance to back out. The default is to back out.

Once the process starts, the image file creation continues until the destination volume is full.

If you started spanning onto a JAZ disk and want to span a 3.0 GB drive onto JAZ disks, you can choose to continue on JAZ disks. If you want to span across different forms of media, you can select an option to span onto a different location.
Record where the span segments are saved and the segment file names. Norton Ghost does not record the locations and file names you selected.

Information about the partitions is stored at the start of the image file. This is updated at the end of the Ghost process, which might require you to reinsert the first disk in the span set. Norton Ghost prompts you for the first disk in the span set and for subsequent volumes when loading from an image.

Loading from a spanned image

When loading a disk or partition from a spanned image file, the process is the same as loading from an unspanned image file. The loading procedure is the reverse of the saving procedure. However, during the loading of the spanned image file, you are prompted for the location of the image file spans. You must know the span segment locations and file names.

You can continue on the same form of media. For example, if you originally spanned onto a JAZ disk and want to restore a 3.0 GB drive from JAZ disks, you can replace the disk and continue from JAZ disks.

To load spanned images without prompting, you can set the AutoName switch on the Ghost main menu under Options.

For more information, see "Adding switches to your cloning task" on page 39.

Image files and tape drives

Norton Ghost support of SCSI tape drives allows the storage of a single image file onto a tape. When written onto the tape, there is no associated file system used, which means that you are unable to access the tape from a drive letter as if it were another storage drive. SCSI tapes do not support spanning to multiple tapes.
When using tape drives with Norton Ghost, the tape drive can be selected as the source or destination device in the File Locator window. Each SCSI tape device is shown as MTx, where x is a number starting at 0 and increasing incrementally for each drive present. For example, the following screen shows a tape drive MT0 available for use.

![File locator window](image)

For Norton Ghost to access SCSI tape drives, a DOS ASPI driver must be installed prior to use.

For more information, see “Setting up the hardware and transfer methods” on page 99.

Norton Ghost in its default mode performs well with most SCSI tape devices. In some situations with older SCSI tape devices and possibly with unreliable tapes, Norton Ghost may need to be configured to slow down or alter the way it uses the tape device.

For more information, see “Command-line switches” on page 75.

**Note:** Ghost Explorer cannot access an image stored on tape.
Image files and CD writers

Norton Ghost support of SCSI and IDE CD writers allows the storage of a single image file onto one or more CD-R/RW. The CDs can be read by any modern CD reader. USB CD writers are not supported by Norton Ghost.

When using CD writers with Norton Ghost, a writer can be selected as the destination device in the File Locator window. Each writer is shown as CD-Rx, where x is a number starting at one and increasing incrementally for each writer present. For example, the following screen shows a CD writer available for use.

For Norton Ghost to access SCSI CD writers, a DOS ASPI driver must be installed prior to use.

For more information, see “Boot disks with CD-ROM support” on page 19.
Norton Ghost should work with most SCSI and IDE writers produced in 2000 or later. It may or may not work with older models. Use the latest firmware available for your CD writer. An IDE CD writer will perform best if it is mounted on the secondary IDE controller. If your CD-R device is not listed, use the Check Image feature of Norton Ghost to ensure that your image can be restored.

For more information see “Cloning a disk to an image file” on page 29.

Norton Ghost has been tested with the following:
- Acer CRW4432A, Acer 8432A, use firmware 5.FV or newer
- Creative Labs 4224, Creative Labs Blaster 8432
- HP 8200, 9110, 9210e
- Imation IMW0802201S
- Iomega ZipCD/Phillips PCRW404
- Lacie 8424 external, Lacie 8/2/20 SCSI external (sensitive to media used)
- LG CED-8080B
- Pacific Digital (Mitsumi) CR-480TE
- Plextor PX-8432, PX-R412, PX-R820, PX-W124, PX-W4220, PX-W8220
- Que PX-W8432Ti
- Ricoh MP9060A
- Smart and Friendly 8220, Smart and Friendly 2224 (sensitive to media used)
- Sony CRX140E, CRX145
- TDK VeloCD
- TEAC CDR-58S (8/24)
- Yamaha 6416S, 8424SZ, CRW8424E

Additional drive support might be available. Check the Norton Ghost product information on the Symantec Web site for a list of currently supported devices.

Use blank CD-R or unformatted CD-RW media with Norton Ghost.

When creating an image on CD, you can make the CD bootable. You need an appropriate boot disk with CD drivers and MSCDEX loaded for this option. The Ghost Boot Wizard can create a suitable boot disk for you.
Start from a disk with appropriate drivers and MSCDEX loaded. Norton Ghost restores images from CD as it does from other media, so the CD-reader must have a CD-drive letter.

For more information, see “Saving an image file to a CD-R/RW” on page 38.

**GoBack and Norton Ghost**

If GoBack is installed on your computer then you cannot directly create image files or restore your computer. To run Norton Ghost with GoBack, do one of the following:

- Uninstall GoBack and then run Norton Ghost as usual to take an image or restore a computer.
- To take an image of your computer, in the GoBack Boot Screen, select the option to start your computer from a floppy disk with the GoBack drivers loaded. You can then use a Norton Ghost boot disk to start Norton Ghost and take an image file.
  
  For more information, see the GoBack user documentation and “Cloning a disk to an image file” on page 29.
- To restore your computer, start your computer from a floppy disk. You can then use a Norton Ghost boot disk to start Norton Ghost and restore your computer.

  For more information, see “Cloning a disk from an image file” on page 31.
Cloning dynamic disks in Windows 2000

Norton Ghost supports the cloning of simple or mirrored volumes on dynamic disks. Cloning of spanned, striped, and RAID-5 volumes is not supported by Norton Ghost. You can dump an image from a partition to a dynamic disk. You can restore this image to a basic disk, but not to a dynamic disk.

To take an image of a Windows 2000 dynamic disk or partition use the partition to image cloning functionality in Norton Ghost. Select the partitions you want to clone. Norton Ghost automatically interprets a dynamic disk for simple and mirrored partition types.

For more information, see "Cloning a partition to an image file" on page 34.

You can restore an image of a dynamic disk to a basic disk only, not to a dynamic disk. After you have restored the image file to a basic disk you can then use Windows 2000 Disk Manager to convert the disk to a dynamic disk.

To convert a dynamic disk to a basic disk you can use GDisk. Use the switch gdisk/mbr/wipe to delete all partitions from the disk. However, this method destroys all data on the disk.

For more information, see "Reinitializing the Master Boot Record" on page 62.

You can only take a disk image of a dynamic disk if you use the image all (-ia) switch. The -ia switch performs a sector-by-sector copy of the entire disk. The disk on which the image is to be loaded must be identical to the source disk in every way. This function is only useful for creating a backup of an image. If you load an image created using -ia onto a drive with different geometry, Windows 2000 does not understand the dynamic disk.

If you load an -ia disk image of a dynamic disk onto an SCSI hard drive and you get the error Destination drive too small, you must load the ASPI driver for the SCSI card. Without an ASPI driver, Norton Ghost does not always have the correct size of the SCSI drive and cannot distinguish if the drive is large enough to hold the image.

**Note:** You should not take an image all of a dynamic disk as the method is slow and the image file would be very big.
CHAPTER 6

Using Ghost Explorer to modify image file contents

The image files that are created when a computer’s hard disk or partition is dumped contain data, applications, and registry settings. These image files can be loaded onto client computers as part of a cloning task. However, the Ghost Explorer utility also lets you view, alter, add, and extract files from an image file. This means that you can add extra files to the image file, rearrange the files within the image file, and extract files from the image file to copy onto client computers.

Ghost Explorer lets you quickly and easily restore files or directories from an image file. Using Ghost Explorer you can:

- View image file contents and save a list of files within an image file.
- Restore files or directories from an image file.
- Add, move, copy, delete, and launch files from and within an image file.
- Use drag-and-drop or cut-and-paste functionality to add files and directories from Windows Explorer to the image file.
- Set span sizes.
- Add a description to an image file.

Note: Right-click a file or directory in Ghost Explorer to access a list of file commands.
Using Ghost Explorer to modify image file contents

Ghost Explorer supports the following partition types:

- FAT12
- FAT16
- FAT32
- Linux Ext2
- NTFS (read only)
- NTFS (read only)

To open Ghost Explorer
- On the Windows taskbar, click **Start** > **Programs** > **Norton Ghost** > **Ghost Explorer**.

Viewing image files

You can view the contents of an image file, including details of the partitions, directories, and files.

There may be some degradation of performance when viewing image files created with Norton Ghost V3. Ghost Explorer cannot view:

- Image files created with a version earlier than version 3.0
- NTFS partitions in image files created by Norton Ghost V3 with compression

You can check the Norton Ghost version in which your image file was created in Ghost Explorer.

For more information, see “Determining Norton Ghost image file version” on page 55.

To view an image file

1. Open Ghost Explorer.
   - For more information, see “To open Ghost Explorer” on page 52.
2. On the File menu, click **Open**.
4. Click **Open**.
5. On the File menu, click **Properties** to view the image file properties.
Restoring a file or directory from an image file

You can restore a file or directory directly from an image file using Ghost Explorer.

To restore a file or directory from an image file

1. In Ghost Explorer, open the image file.
2. Select the file or directory to be restored.
3. On the File menu, click Restore.
4. Select the location to which you want to restore the file or directory.
5. Click Restore to restore the file or directory to the chosen location.

Note: You can also drag and drop a file from Ghost Explorer to Windows Explorer to restore it.

Modifying image files in Ghost Explorer

You can use Ghost Explorer to add files or directories from Windows Explorer to any image file that was created in Norton Ghost version 6.0 or greater and is not NTFS. You can also delete files from any image file that was created in Norton Ghost v5.1c or a later version and is not NTFS.

You can check the version of Norton Ghost used to create your image file in Ghost Explorer.

For more information, see “Determining Norton Ghost image file version” on page 55.

Adding, moving, and deleting files

Within image files, Ghost Explorer supports Windows cut-and-paste operations, including copying, pasting, moving, deleting, and adding files to images. You can also drag and drop from Windows Explorer to Ghost Explorer.
Using Ghost Explorer to modify image file contents

Saving a list of contents of an image file

You can save a text file that contains a list of the directories (and optionally, files and their details) that are in the current image file.

To save a list of the contents of an image file
1 In Ghost Explorer, open the image file.
2 On the File menu, click Save Contents.
3 Do one of the following:
   - Click Directories only to include directories only.
   - Click Include Files to include files.
   - Click Include Details to include file details.
4 Select a directory to which to save the text file.
5 Type a file name.
6 Click Save.

Setting span file sizes

Norton Ghost lets you split an image file into smaller files called spans. The Span Split Point function in Ghost Explorer lets you set the size of each span so that when you add files or directories, each span file does not get bigger than the specified size.

To set a span file size
1 On the View menu, click Options.
2 In the Span Split Point (MB) field, type the required size.
3 Click Autoname Spans if you want Ghost Explorer to choose a default name for additional span files that it creates.

Compiling a file

If you add or delete files from within an image file, the image file becomes fragmented. Norton Ghost takes longer to restore a fragmented image than a compiled file. Compiling a file defragments it, which improves performance when restoring.
Check the properties of the image file to see whether compilation is recommended.

**To compile a file**

1. On the File menu, click **Properties**.
2. On the File menu, click **Compile** if compilation is recommended.
3. Type a new name for the compiled file.
4. Click **Save**.

### Determining Norton Ghost image file version

Whether you can add, delete, or view an image file, or move files within an image file, depends on the version of Norton Ghost that was used to create the image file. Ghost Explorer cannot open a file created with a version of Norton Ghost earlier than 3.0. If the image file was created in Norton Ghost 3.0 or greater, you can determine the version by looking at its properties in Ghost Explorer.

**To determine the version of Norton Ghost used to create an image file**

1. In Ghost Explorer, open the image file.
2. On the File menu, click **Properties**.

   The Properties window appears. The version of Norton Ghost used to create the image file appears next to Produced by Ghost version.

### Using Ghost Explorer from the command line

You can start Ghost Explorer from an MS-DOS prompt by typing its path and file name. For example:

C:\Progra~1\Symantec\Norton~1\Ghostexp

**Note:** If Ghost Explorer is in the current directory, or in a directory on your path, you do not need to type the path name.

You can also provide a Ghost image file as an argument for Ghost Explorer to open. For example:

Ghostexp n:\Images\Myimage.gho
Using Ghost Explorer to modify image file contents

If Ghost Explorer reports a corruption in your image file, you may be able to get further details of the nature of the corruption. Normally, you would only use these options when asked to do so by Ghost Explorer Technical Support. Start the program with one of the following arguments:

- `-d1` Reports on corruptions or significant events in FAT file systems.
- `-d2` Reports on corruptions or significant events in NTFS file systems.
- `-d4` Reports on corruptions or significant events in Ext2 files.

The reports are presented to you as dialog boxes. You can use all switches, or use `-d7` to turn on all options.

Ghost Explorer has a batch mode in which it carries out a single command and then exits. In this version, batch mode supports the saving of the contents to a text file only. To use this mode, specify one of the following switches:

- `-t` Save the list of directories in the dump file to a file with the same name as the image file but with an extension of .txt.
- `-tf` Save a list of directories and files.
- `-tv` Save a verbose listing of directories and files.
- `-tvfl=filename` Save the list to the file specified.

For more information, see “Saving a list of contents of an image file” on page 54.

If Ghost Explorer reports that a spanned or split image is corrupt without prompting for the second part of the image, it may not recognize that the image is split. Starting with the `-split` argument forces Ghost Explorer to treat an image as a split image.

The image index created by versions of Norton Ghost prior to 5.1c did not handle long file names containing double byte characters correctly, such as file names in Asian or Eastern European languages. Ghost Explorer may be able to show these names properly by reading them directly from the image file instead of from the index. However, the loading of the image is much slower. Use the switch `-ignoreindex` to force this behavior.
GDisk lets you create partitions, reinitialize Master Boot Records, and delete and wipe your disks in many different ways.

Two versions of GDisk are supplied with Norton Ghost:
- GDisk: Runs in DOS
- GDisk32: Runs from the command-line in a Windows operating system

All GDisk command-line switches can be run with GDisk32.

GDisk is a complete replacement for the Fdisk and Format utilities that offers:
- On-the-fly formatting.
- Extensive partition reporting.
- High security disk wiping.
- The ability to hide a partition or make a hidden partition visible.

Unlike Fdisk, which uses interactive menus and prompts, GDisk is command-line driven. This offers quicker configuration of a disk's partitions and the ability to define GDisk operations in a batch file.
Running GDisk

Run either GDisk in DOS or GDisk32 in Windows.

To run GDisk
1. Start your computer in DOS mode.
2. At the DOS prompt, type `progra~1\symantec \Norton~1\GDisk` followed by the required disk and switches.

To run GDisk32
1. On the Windows taskbar, click Start > Programs > MS-DOS Prompt.
2. At the DOS prompt, type `progra~1\symantec \Norton~1\GDisk32` followed by the required disk and switches.

Overview of main command-line switches

GDisk has nine main modes of operation. The first four correspond to the menu options on the Fdisk main menu. The mode in which GDisk operates is selected by one of the following switches:

<table>
<thead>
<tr>
<th>Mode</th>
<th>Switch</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create</td>
<td>/cre</td>
<td>Create partitions: primary DOS partitions, extended DOS partitions.</td>
</tr>
<tr>
<td>Delete</td>
<td>/del</td>
<td>Delete partitions of any type, including nonDOS partitions.</td>
</tr>
<tr>
<td>Status (default)</td>
<td>/status</td>
<td>List information on the specified fixed disk and its partitions.</td>
</tr>
<tr>
<td>Activate</td>
<td>/act</td>
<td>Activate and deactivate a partition (specifying it as the bootable partition).</td>
</tr>
<tr>
<td>Hide</td>
<td>/hide</td>
<td>Hide an existing partition or unhide a hidden partition.</td>
</tr>
<tr>
<td>Reinitialize MBR</td>
<td>/mbr</td>
<td>Reinitialize the Master Boot Record.</td>
</tr>
<tr>
<td>Batch</td>
<td>/batch</td>
<td>Use batch-mode command execution.</td>
</tr>
</tbody>
</table>
Overview of main command-line switches

<table>
<thead>
<tr>
<th>Mode</th>
<th>Switch</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disk wipe</td>
<td>/diskwipe</td>
<td>Wipe the contents of the whole disk.</td>
</tr>
<tr>
<td>boot.ini</td>
<td>/bootini</td>
<td>Makes a modification to the Windows NT/2000 boot menu. This switch functions with GDisk32 only.</td>
</tr>
</tbody>
</table>

Online Help for command-line switches

You can get an overview of the nine modes of operation and their switches by using the Help switch:

- GDisk: C:\progra~1\symantec\Norton~1\gdisk /?
- GDisk32: C:\progra~1\symantec\Norton~1\gdisk32 /?

**Note:** An additional switch not shown in Help is the /VERSION switch. This switch shows the version information for the GDisk executable.

More detailed Help is available by qualifying the Help command with the switch for one of the eight main modes of operation.

For example, to view the detailed Help file for Hide, type one of the following command lines:

- GDisk: C:\progra~1\symantec\Norton~1\gdisk /hide /?
- GDisk32: C:\progra~1\symantec\Norton~1\gdisk32 /hide /?
Managing partitions using GDisk

Switches common to all GDisk commands

You can use the following switches for any of the nine main operations:

<table>
<thead>
<tr>
<th>Switch</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>/x</td>
<td>Prevents GDisk from using extended disk access support. This may result in GDisk not being aware of the full capacity of the disk.</td>
</tr>
<tr>
<td>/i</td>
<td>Prevents GDisk from using direct IDE disk-access support. This may result in GDisk not being aware of the full capacity of the disk.</td>
</tr>
<tr>
<td>/s</td>
<td>Prevents GDisk from using direct SCSI disk-access support. This may result in GDisk not being aware of the full capacity of the disk.</td>
</tr>
<tr>
<td>/y</td>
<td>Suppresses prompting to confirm the operation. If you do not use this switch, you are not necessarily prompted before a partition is deleted or another possibly destructive operation is executed.</td>
</tr>
<tr>
<td>/sure</td>
<td>Suppresses prompting to confirm the operation. Same functionality as /y.</td>
</tr>
<tr>
<td>/r</td>
<td>Causes GDisk to restart the computer if the operation is successful.</td>
</tr>
</tbody>
</table>

Creating a partition

The create switch creates a partition of the specified type using the largest block of unused disk space. The partition is not formatted during the operation unless the /for switch is used. You cannot create a dynamic disk partition.

Depending on the version of GDisk that you require, the syntax for this command is one of the following:


<table>
<thead>
<tr>
<th>Switch</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>disk</td>
<td>Represents the physical fixed disk, 1 to 8.</td>
</tr>
<tr>
<td>/cre</td>
<td>Creates a DOS partition or logical DOS drive.</td>
</tr>
<tr>
<td>/pri</td>
<td>Creates a primary DOS partition.</td>
</tr>
</tbody>
</table>
**Creating a partition**

<table>
<thead>
<tr>
<th>Switch</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>/ext</td>
<td>Creates an extended DOS partition.</td>
</tr>
<tr>
<td>/log</td>
<td>Creates a logical DOS drive in the extended DOS partition.</td>
</tr>
<tr>
<td>/sz:MB</td>
<td>Specifies the size of the partition in megabytes (MB). This is rounded up to the nearest cylinder.</td>
</tr>
<tr>
<td>/sz:pcent</td>
<td>Specifies the size of the partition as a percentage of the total disk size, not the available disk space.</td>
</tr>
<tr>
<td>/end</td>
<td>Creates the partition at the end of the free space. If this switch is not used, then the partition is created at the beginning of the free space.</td>
</tr>
<tr>
<td>/for</td>
<td>Formats the new partition once it has been created. Unless the /ntfat16 or /-32 switches are used, the partition type is determined by the following:</td>
</tr>
<tr>
<td></td>
<td>- If the partition is less than 16MB: FAT12</td>
</tr>
<tr>
<td></td>
<td>- If the partition is between 16MB and 512MB: FAT16</td>
</tr>
<tr>
<td></td>
<td>- If the partition is greater than 512MB: FAT32</td>
</tr>
<tr>
<td>/q</td>
<td>Performs a quick format if used in combination with the /for switch. If you do not use this switch, then GDisk performs a surface scan of the partition and marks any bad sectors.</td>
</tr>
<tr>
<td>/v:[label]</td>
<td>Gives the new formatted partition the specified label when used in combination with the /for switch.</td>
</tr>
<tr>
<td>/-32</td>
<td>Indicates that the partition is not formatted as FAT32. Limits primary and logical partitions to 204 MB. Partitions over 16 MB are formatted as FAT16. This switch is useful if the operating system does not support FAT32 (for example, Windows NT4).</td>
</tr>
<tr>
<td>/ntfat16</td>
<td>Indicates that the partition is not formatted as FAT32, but 64 KB, cluster FAT16 is allowed. This limits primary and logical partitions to 4097 MB. Partitions over 16 MB are formatted as FAT16. Windows 9x and DOS systems are unable to access partitions created with this switch and that are over 2048 MB.</td>
</tr>
</tbody>
</table>
Managing partitions using GDisk

Reinitializing the Master Boot Record

Use the /mbr switch to rewrite the boot code in the Master Boot Record (MBR). You may need to reinitialize the MBR to eliminate a boot sector virus residing there. You can also use the /mbr switch with the /wipe option to delete a dynamic disk.

**Note:** This switch must be used when deleting Linux partitions if LILO resides in the MBR.

Depending on the version of GDisk that you require, the syntax for this command is one of the following:
- GDisk: gdisk disk /mbr [/wipe]
- GDisk32: gdisk32 disk /mbr [/wipe]

<table>
<thead>
<tr>
<th>Switch</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>disk</td>
<td>Represents the physical fixed disk, 1 to 8.</td>
</tr>
<tr>
<td>/mbr</td>
<td>Reinitializes the boot code in the Master Boot Record.</td>
</tr>
<tr>
<td>/wipe</td>
<td>Deletes the partition on the disk.</td>
</tr>
</tbody>
</table>

Showing information about disks

The status switch shows information about the fixed disks and partitions on a disk, including the model of the disk. You must specify the disk number to get information about the partitions on a disk.

Depending on the version of GDisk that you require, the syntax for this command is one of the following:

<table>
<thead>
<tr>
<th>Switch</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>disk</td>
<td>Represents the physical fixed disk, 1 to 8.</td>
</tr>
<tr>
<td>/raw</td>
<td>Shows the contents of the partition table in CHS form if used with the disk switch.</td>
</tr>
</tbody>
</table>
Performing multiple GDisk operations using batch mode

Use the batch mode switch, /batch, to perform multiple GDisk operations with a single command. Using the batch switch lets you avoid loading GDisk from the boot disk each time. Batch commands can either be supplied interactively at a prompt or in a pre-prepared text file.

If the name of a text file is supplied along with the batch mode switch, GDisk opens the file and executes the commands within it until all commands have been executed or one of the commands encounters an error.

**Note:** To use the Windows version of GDisk in the example commands, replace gdisk with gdisk32.

For example:

C:\> gdisk /batch:cmds.gg

If the batch mode switch is supplied without a file name, GDisk prompts for the commands to execute.

Command-line arguments that apply to all of the batch commands can be specified on the original command line along with the batch mode switch. The lines found in the batch file (or typed at the prompt) are appended to the already partially formed command line.

<table>
<thead>
<tr>
<th>Switch</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>/lba</td>
<td>Shows the contents of the partition table in logical block form if used with the disk switch.</td>
</tr>
<tr>
<td>/ser</td>
<td>Shows the serial number of the disk.</td>
</tr>
</tbody>
</table>

Performing multiple GDisk operations using batch mode
Managing partitions using G Disk

Following is an example batch command file called Two-new.gg. Blank lines and lines starting with the hash symbol are considered comments. These lines are ignored. (In this example, the commands do not specify the fixed disk on which to operate.)

# delete all partitions
/del /all
# create formatted FAT16 primary DOS partition
/cre /pri /-32 /for /q
/cre /ext
# create formatted FAT16 logical DOS partition
/cre /log /-32 /for /q

The following command deletes all partitions and creates two new ones on the second fixed disk with confirmation prompting turned off:

gdisk 2 /y /batch:two-new.gg

The four commands to be executed are a combination of the original command plus the commands from the batch file:

gdisk 2 /y /del /all
gdisk 2 /y /cre /pri /-32 /for /q
gdisk 2 /y /cre /ext
gdisk 2 /y /cre /log /-32 /for /q

Batch files may be nested recursively, so if a second file called Std_init.gg contained the following lines:

1 /batch:two-new.gg
2 /batch:two-new.gg

then this command performs the actions of Two-new.gg on both fixed disks:

gdisk /batch:std-init.gg
FAT16 partitions in Windows NT

FAT16 partitions can be up to 4 GB in size using 64 K clusters in Windows NT. GDisk can create a FAT16 partition using 64 K clusters when the /Ntfat16 switch is added to the create partition command line. This switch disables the creation of FAT32 partitions and allows the creation of FAT16 partitions up to 4 GB.

Note: DOS and Windows 9x do not support FAT16 partitions using 64 K clusters and are limited to 2 GB FAT16 partitions.

Deleting and wiping your disk

GDisk lets you delete data and partitions on your disk or wipe your entire disk. You cannot delete a dynamic disk partition with the /del switch.

The switch /del/all deletes all partitions that are on the disk. Any other space that has not been used for creating a partition is not deleted. Deleting an extended partition also deletes any logical partition within it.

The /diskwipe switch wipes the entire disk, partitions, partition table, MBR, and all used and unused spaces.

Depending on the version of GDisk that you require, the syntax for the delete switch is one of the following:

Managing partitions using G Disk

Depending on the version of GDisk that you require, the syntax for the diskwipe switch is one of the following:

- GDisk: gdisk disk /diskwipe [dodwipe | /customwipe:n]
- GDisk32: gdisk32 disk /diskwipe [dodwipe | /customwipe:n]

<table>
<thead>
<tr>
<th>Switch</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>disk</td>
<td>Represents the physical fixed disk, 1 to 8.</td>
</tr>
<tr>
<td>/del</td>
<td>Deletes a DOS partition or logical DOS drive.</td>
</tr>
<tr>
<td>/pri[:nth]</td>
<td>Deletes the nth primary DOS partition. The default is 1.</td>
</tr>
<tr>
<td>/ext[:nth]</td>
<td>Deletes the nth extended DOS partition. The default is 1. Also deletes any logical partitions in the extended partition.</td>
</tr>
<tr>
<td>/log[:nth]</td>
<td>Deletes the nth logical DOS drive from the extended DOS partition.</td>
</tr>
<tr>
<td>/p:partn-no</td>
<td>Indicates the partition to delete. Use the number reported by GDisk in standard display mode (not using /lba or /raw) for partn-no.</td>
</tr>
<tr>
<td>/all</td>
<td>Deletes all partitions.</td>
</tr>
<tr>
<td>/qwipe</td>
<td>Overwrites the partition’s data area before deleting the partition. Makes one pass of the disk.</td>
</tr>
<tr>
<td>/dodwipe</td>
<td>Overwrites the partition’s data area before deleting the partition. Makes seven passes of the disk. This is the security standard for the U.S. Department of Defense.</td>
</tr>
<tr>
<td>/customwipe: n</td>
<td>Overwrites the partition’s data area n times before deleting the partition. n can be set from 1 to 100. /customwipe:7 is equivalent to /dodwipe.</td>
</tr>
</tbody>
</table>

For example:

- gdisk 1 /del /all /qwipe completes one pass to delete all partitions and data on disk 1.
- gdisk 1 /del /p:2 /qwipe wipes partition 2 on disk 1 with one pass.
- gdisk 1 /diskwipe /customwipe:15 wipes the entire disk with 15 passes.
Activate or deactivate a partition

A computer boots to an active partition. Using the /act or /-act switches you can choose the partition to which the computer starts.

Depending on the version of GDisk that you require, the syntax for this command is one of the following:

- GDisk: gdisk disk /-lact /p:partn-no
- GDisk32: gdisk32 disk /-lact /p:partn-no

<table>
<thead>
<tr>
<th>Switch</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>disk</td>
<td>Represents the physical fixed disk, 1 to 8.</td>
</tr>
<tr>
<td>/act</td>
<td>Activates a partition.</td>
</tr>
<tr>
<td>/-act</td>
<td>Deactivates a partition.</td>
</tr>
<tr>
<td>/p:partn-no</td>
<td>Indicates the partition to activate or deactivate. Only primary partitions can be activated. Use the number reported by GDisk in standard display mode (not using /lba or /raw) for partn-no.</td>
</tr>
</tbody>
</table>

Hide or unhide a partition

You can hide a partition so that a user cannot see it.

Depending on the version of GDisk that you require, the syntax for this command is one of the following:

- GDisk: gdisk disk /-lhide /p:partn-no
- GDisk32: gdisk32 disk /-lhide /p:partn-no

<table>
<thead>
<tr>
<th>Switch</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>disk</td>
<td>Represents the physical fixed disk, 1 to 8.</td>
</tr>
<tr>
<td>/hide</td>
<td>Hides a partition.</td>
</tr>
<tr>
<td>/-hide</td>
<td>Unhides a partition.</td>
</tr>
<tr>
<td>/p:partn-no</td>
<td>Indicates the partition to hide or unhide. Use the number reported by GDisk in standard display mode (not using /lba or /raw) for partn-no.</td>
</tr>
</tbody>
</table>

Modify the Windows NT/2000 boot menu

The /bootini switch lets you make a modification to a Windows NT/2000 boot menu. The following modifications are supported:

- Displaying a list of current boot entries
- Adding an entry to Boot.ini
- Removing an entry from Boot.ini
- Setting the default boot option and timeout

This switch is operational with GDisk32 only.

When GDisk changes the state of Boot.ini, a copy of the current Boot.ini is created. The copy is named either C:\boot_gdisk32_copy.ini or C:\boot.ini_gdisk32_copy.

Specifying the boot.ini path and file name

The /inifile switch is common to all operations performed with the /bootini switch.

/inifile lets you specify the full path and file name of the current Windows NT/2000 Boot.ini file. This lets you locate Boot.ini if it is not on the C drive.

The default value for this switch is C:\boot.ini.

Displaying the list of current boot entries

Use the /bootini switch to display the existing boot menu for the current Windows NT/2000 operating system.

The syntax for this command is as follows:

gdisk32 /bootini [/inifile:filename]
Adding an entry to Boot.ini

There are two types of entries that can be added to a Boot.ini file:

- Start another installation of Windows NT/2000 that resides on a different partition.
- Start a non-Windows NT/2000 operating system that resides on a different partition.

G Disk does not add an entry to Boot.ini if:

- An entry with the description already exists in Boot.ini (case insensitive).
- The referenced partition is of type Extended.
- The referenced partition is hidden.

The following table describes the function of each switch for both types of entries.

<table>
<thead>
<tr>
<th>Switch</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>/bootini</td>
<td>Modifies Boot.ini.</td>
</tr>
<tr>
<td>/add</td>
<td>Creates a new entry in Boot.ini.</td>
</tr>
<tr>
<td>/d:diskno</td>
<td>Physical fixed disk, from 1 through 8.</td>
</tr>
<tr>
<td>/p:partno</td>
<td>Number of the partition from which to boot.</td>
</tr>
<tr>
<td>/desc:desc</td>
<td>Description to appear in the NT boot loader menu.</td>
</tr>
<tr>
<td>/inifile:filename</td>
<td>The full path and file name for Boot.ini. The default value is C:\boot.ini.</td>
</tr>
<tr>
<td>/bsectfile:filename</td>
<td>Boot sector file to create. For example, C:\bsect.dat.</td>
</tr>
<tr>
<td>/winnt</td>
<td>Adds an entry to start Windows NT/2000 operating system.</td>
</tr>
<tr>
<td>/sysfolder:folder</td>
<td>System folder on the Windows NT/2000 operating system from which to start. The default value is Winnt.</td>
</tr>
<tr>
<td>/r</td>
<td>Restart after the execution of the command.</td>
</tr>
</tbody>
</table>
Managing partitions using GDisk

Adding an entry for starting Windows NT/2000

The syntax for this command is as follows:

gdisk32 /bootini /add /d:diskno /p:partno /desc:description /winnt [/ 
sysfolder:folder] [/inifile:filename] [/r]

This entry uses the Advanced RISC Computing (ARC) style path to describe the relative disk location for the entry. The entry has the following format:

<ARC style path>\<system folder>="description"

For example:

multi(0)disk(0)rdisk(0)partition(1)\winnt="Boot NT System"

For more information, see the Microsoft Knowledge Base article Q102873 - “BOOT.INI and ARC Path Naming Conventions and Usage.”

Note the following:

- GDisk uses only MULTI(X) syntax when describing ARC style paths, (as opposed to SCSI(X)).
- GDisk always uses multi(0)disk(0) as the beginning of the ARC style path.
- /winnt instructs GDisk32 to create an ARC style entry and must be used if the target operating system is Windows NT/2000. If this switch is not used, then GDisk32 creates an entry as if the target operating system is not Windows NT/2000.
- /sysfolder lets you specify the Windows system folder on the target operating system. The system folder is usually Winnt. If the system folder is not Winnt, then provide the path to this folder, but do not include the root directory.

For example, use /sysfolder:"2k\WinNt", not /sysfolder:"F:2k\WinNt".
Adding an entry for starting a nonWindows NT/2000 operating system

The syntax for this command is as follows:

```plaintext
```

This entry to Boot.ini references a boot sector file used to continue the starting process.

The entry has the following format:

```
<full path to boot sector file>/<boot sector file>="description"
```

For example:

```
C:\bootos2s.dat="Boot OS/2 System"
```

When adding this entry, GDisk does the following:

- Reads the first sector of the targeted partition (boot sector)
- Writes out the contents of that sector to a boot sector file
- Adds a reference to that boot sector file to Boot.ini

The /bsectfile switch lets you specify the full path and file name for the boot sector file that is created.

GDisk32 does the following by default:

- Builds the file name from the entry descriptions, omitting any invalid characters under DOS rules for 8.3 file name format.
- The boot sector file is created in the root directory of the C drive and has a .dat file extension.

For example: gdisk32 /add /d:1 /p:2 /desc:*** Boot OS/2 ***
produces a boot sector file C:\bootos2.dat.
Removing an entry from Boot.ini

The syntax to remove an entry from Boot.ini as follows:

```
gdisk32 /bootini /remove /entry:no [/inifile:filename] [/r]
```

<table>
<thead>
<tr>
<th>Switch</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>/remove</td>
<td>Removes the entry from Boot.ini.</td>
</tr>
<tr>
<td>/entry:no</td>
<td>Removes the ID of the entry from Boot.ini.</td>
</tr>
</tbody>
</table>

If the entry to be removed is the default boot option, GDisk removes the entry and sets the first entry in the remaining list as the default boot entry.

GDisk does not remove the entry if it is the only entry in Boot.ini.

Setting the default boot option and timeout

Use the /default switch to set the default boot option and timeout.

The syntax for this command is as follows:

```
```

<table>
<thead>
<tr>
<th>Switch</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>/default</td>
<td>Sets the default boot option and timeout.</td>
</tr>
<tr>
<td>/entry:no</td>
<td>Sets the ID of entry as the default boot option.</td>
</tr>
<tr>
<td>/timeout:sec</td>
<td>Sets the number of seconds before the default boot option is selected.</td>
</tr>
</tbody>
</table>
Support for large hard disks

GDisk includes large disk drive support for IDE and SCSI hard drives (disks that exceed the 1024 Cylinder BIOS limitation, which translates to a capacity greater than 7.8 GB). GDisk can directly access hard disks through the IDE controller or ASPI interface provided by an ASPI driver. Take care when creating partitions for operating systems with inherent partition size limitations.

Remember the following information when creating partitions for use in Windows 95/98:

- On systems with a PC BIOS that does not support interrupt 13h extended disk services, take care to ensure that the partitions created can be used as intended. When a primary partition or extended partition starts or ends past the 7.8 GB limit of the hard drive, it is not accessible on such systems in Windows or in DOS-only mode. This affects all logical partitions contained within an extended partition starting or ending past the limit.

Remember the following information when you create partitions for use in Windows NT:

- According to the Microsoft Support Knowledgebase, Windows NT NTFS bootable partitions cannot exceed 7.8 GB (8,455,716,864 bytes). This information is detailed in the Windows Knowledgebase Article “Windows NT Boot Process and Hard Disk Constraints,” Article ID: Q114841.
  
  Nonbootable NTFS partitions do not have this size limitation.

- NT cannot start from partitions that start or end over the 1024-cylinder boundary. If this condition exists, NT reports a “Boot Record Signature AA55 Not Found” error message.

Windows NT does not support drives larger than 7.8 GB unless you install Service Pack 4 or apply the ATAPI hot fix to Service Pack 3. This information is included in the Windows Knowledgebase Article “IBM DTTA-351010 10.1 GB Drive Capacity Is Inaccurate,” Article ID: Q183654.
Managing partitions using G Disk
Norton Ghost can be run:

- Interactively with no command-line switches
- Interactively with selected switches

The Norton Ghost command-line switches are used to alter Norton Ghost behavior and automate procedures.

**To list Norton Ghost command-line switches**

- In the Ghost directory, type one of the following:
  - `ghostpe.exe -h`
  - `ghostpe.exe -?`

A hyphen (-) or a slash (/) must precede all switches except @. Switches are not case sensitive. They can be entered in upper, lower, or mixed case.

@filename

Specifies a file containing additional command-line switches that should be read. Filename indicates the path and file name of the command-line switch file. The command-line switch file can include any Norton Ghost command-line switch, except for -afile and -dfile. The Norton Ghost command-line switch file must be a text file with each switch on a new line. This feature lets you exceed the DOS command-line limit of 150 characters.

For example, for the following command line:

`ghostpe.exe @ghswitch.txt`

The file Ghswitch.txt would read:

```
-clone,mode=pdump,src=1:2,dst=g:\part2.gho
-fcr
```
Command-line switches

-#e=filename
Standalone switch to bind and activate Norton Ghost using the license details included in the environment file. Useful when installing or upgrading Norton Ghost to a newer version. If the file name is not given, it defaults to Ghost.env. The environment file is created when Norton Ghost is first licensed.

-afiled=filename
Overrides the default abort error log file (Ghosterr.txt) to the directory and file given in filename.

-auto
Automatically names spanned image files during creation. Using this switch avoids the user prompt that asks for confirmation of the next destination location for the remainder of the image file that is being loaded.

-bfc
Handles bad FAT clusters when writing to disk. If this switch is set, and the target partition is FAT, Norton Ghost checks for and works around bad sectors. This option may slow Norton Ghost operation substantially.

-bootcd
When writing an image directly to a CD writer, make the CD bootable. You need a bootable floppy disk in drive A.

-chkimg, filename
Checks the integrity of the image file indicated by filename.

-clone
Clone operation switch. This switch allows automation of Norton Ghost operations and has a series of arguments that define the operation parameters. No spaces are allowed in the command line. The number of size switches depends on the number of partition sizes that you want to specify. There may be none.

For more information, see “Clone switch syntax” on page 89.
-cns

Reverts the naming of spanned files to the system used by versions of Norton Ghost previous to Norton Ghost 2002. If this switch is not used then the naming of spanned files conforms to Microsoft application guidelines. For example:

<table>
<thead>
<tr>
<th>With -cns</th>
<th>Without -cns</th>
</tr>
</thead>
<tbody>
<tr>
<td>image.gho</td>
<td>image.gho</td>
</tr>
<tr>
<td>image.001</td>
<td>image001.ghs</td>
</tr>
<tr>
<td>image.002</td>
<td>image002.ghs</td>
</tr>
</tbody>
</table>

-CRC32

The -CRC32 switch lets you make a list of the files on a disk or partition, or create an image file with CRC values, and to verify the list against the original or a clone. The purpose is to allow both quick listing of the contents of an image file and verification that a disk created by Norton Ghost contains the same files as the original.

For more information, see “CRC32 switch usage” on page 94.

-crcignore

Ignores CRC errors. CRC errors indicate data corruption. This switch overrides the CRC error detection and may let a corrupted image file be used. Using this switch leaves the corrupted files in an unknown state.

-dd

Dumps disk metrics information to the dump log file Ghststat.dmp. The file location can be altered using the -dfile=filename switch.

-dfile=filename

Changes the path and file name of the dump log file created using the -dd switch. This switch cannot be included in the @ Ghost switch text file.
Command-line switches

-di

Shows diagnostics. This is useful for Technical Support purposes. For each
disk present on the computer, the physical attributes such as drive number,
cylinders, heads, sectors per track, and total sectors appear. The diagnostics
may be redirected to a file and given to Technical Support to assist with
problem solving.

Example:
ghostpe.exe -di > diag.txt

outputs disk diagnostics to the file Diag.txt.

-dl=number

Specifies the number of hard drives present. Valid numbers are between 1
and 8. This may help when the BIOS does not report the number of drives
correctly.

-f32

 Lets Norton Ghost convert all FAT16 volumes to FAT32 volumes when the
destination partition is larger than 256 MB in size. Ensure that the installed
operating systems requiring access to the volumes that will be converted
support FAT32.

-f64

 Lets Norton Ghost resize FAT16 partitions to be greater than 2047 MB using
64 K clusters. This is only supported by Windows NT and Windows 2000.
Do not use on computers with other operating systems.

-fatlimit

Limits the size of FAT16 partitions to 2047 MB. Useful when Windows NT
FAT16 partitions are present on the disk, and 64 K clusters are not wanted.

-fcr

Creates a CRC32 file (called Ghost.crc) while creating an image file.

For more information, see “.CRC32” on page 77.
-fdsp
Preserves the signature bytes on the destination disk when performing a
disk-to-disk or image-to-disk cloning operation.

-fdsz
Clears the signature bytes on the destination disk when performing a
disk-to-disk or image-to-disk cloning operation.

-femax
When an extended partition is created in a disk-to-disk or image-to-disk
operation, the extended partition takes up as much disk space as allowed.

-ffi
Prefers the use of direct IDE access for IDE hard disk operations. This
switch does not have any effect when running Norton Ghost in Windows
98.

-ffs
Prefers the use of direct ASPI/SCSI disk access for SCSI hard disk
operations.

-ffx
Prefers the use of Extended Interrupt 13h disk access for hard disk
operations.

-finger
Shows the fingerprint details written on a hard disk created by Norton
Ghost. The fingerprint details include the process used to create the disk or
partition and the time, date, and disk on which the operation was
performed.

-fis
Use all available disk space when creating partitions. By default, Norton
Ghost often leaves a small amount of free space at the end of the disk.
Because partitions must be aligned to cylinder boundaries, Norton Ghost
may leave up to 5 MB free even when -fis is specified.
Command-line switches

-fni
Disables direct IDE access support for IDE hard disk operations.

-fns
Disables direct ASPI/SCSI access support for SCSI hard disk operations.

-fnx
Disables extended INT13 support for hard disk operations.

-fro
Forces Norton Ghost to continue cloning even if the source contains bad clusters.

-fx
Flag exit. Causes Norton Ghost to exit to DOS after operation completion. By default, Norton Ghost prompts the user to restart or exit when the operation has finished. For more information, see “-rb” on page 85.

-h or -?
Shows the Norton Ghost command-line switch Help page.

-ia
Image all. The image all switch forces Norton Ghost to perform a sector-by-sector copy of all partitions. When copying a partition from a disk to an image file or to another disk, Norton Ghost examines the source partition and decides whether to copy just the files and directory structure, or to do a sector-by-sector copy. If it understands the internal format of the partition, it defaults to copying the files and directory structure. Generally this is the best option. However, if a disk has been set up with special hidden security files that are in specific positions on the partition, the only way to reproduce them accurately on the target partition is through a sector-by-sector copy. If you use this switch to create an image of a dynamic disk, then the image must be loaded to a disk with identical geometry.

-ial
Forces a sector-by-sector copy of Linux partitions. Other partitions are copied as normal.
-ib

Image boot. Copies the entire boot track, including the boot sector, when creating a disk image file or copying disk-to-disk. Use this switch when installed applications, such as boot-time utilities use the boot track to store information. By default, Norton Ghost copies only the boot sector, and does not copy the remainder boot track. You cannot perform partition-to-partition or partition-to-image functions with the -ib switch.

-id

Image disk. Similar to -ia (image all), but also copies the boot track, as in -ib (image boot), extended partition tables, and unpartitioned space on the disk. When looking at an image with -id, you see the unpartitioned space and extended partitions in the list of partitions. The -id switch is primarily used by law enforcement agencies that require forensic images.

When Norton Ghost restores from an -id image, it relocates partitions to cylinder boundaries and adjusts partition tables accordingly. Head, sector, and cylinder information in partition tables is adjusted to match the geometry of the destination disk. Partitions are not resizeable. You will need an identical or larger disk than the original.

Norton Ghost does not wipe the destination disk when restoring from an -id image. Geometry differences between disks may leave tracks on the destination disk with their previous contents.

Use the -ia (image all) switch instead of the -id switch when copying partition-to-partition or partition-to-image. An individual partition can be restored from an image created with -id.

-ir

Image raw. Copies the entire disk, ignoring the partition table. This is useful when a disk does not contain a partition table in the standard PC format, or you do not want partitions to be realigned to track boundaries on the destination disk. Some operating systems may not be able to access unaligned partitions. Partitions cannot be resized on restore and you need an identical or larger disk.
**Command-line switches**

**-jl:x=filename**

Creates a log file to assist in diagnosing problems. The amount of information logged is set by the log level x. The log level x can be E (errors), S (statistics), W (warnings), I (information), or A (all) in increasing order of logging detail. The file name indicates the path and file name of the log to be created. In general, the error and statistic levels do not affect session performance. All other levels may reduce performance and should be used for diagnostic purposes only.

**-lockinfo**

Shows the type code and information stored in the BIOS, or the Pentium III Processor ID.

For example:

<table>
<thead>
<tr>
<th>Type</th>
<th>Based On</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>M</td>
<td>Manufacturer</td>
<td>Compaq</td>
</tr>
<tr>
<td>P</td>
<td>Product name</td>
<td>Deskpro EN Series SFF</td>
</tr>
<tr>
<td>V</td>
<td>Version</td>
<td>Compaq</td>
</tr>
<tr>
<td>S</td>
<td>Serial number</td>
<td>H925CKH60020</td>
</tr>
<tr>
<td>U</td>
<td>UUID</td>
<td>2DA9379B4707D31185E8C800A4F232BC</td>
</tr>
<tr>
<td>C</td>
<td>M&amp;P combined</td>
<td>Compaq Deskpro EN Series SFF</td>
</tr>
<tr>
<td>I</td>
<td>PIII ID</td>
<td>0000067200028E72A6994A20</td>
</tr>
</tbody>
</table>

**-locktype= Type**

Lets you lock an image file for use with a specific set of computers defined by the type chosen and the source computer.

For example, ghost -locktype=P creates an image that can be used only on systems that have the same product name type as the source computer.

**-lpm**

LPT master mode. This switch causes Norton Ghost to automatically go into LPT master mode, and is the equivalent of selecting LPT Master from the main menu.

For more information, see “Peer-to-peer connections” on page 99.
-lps

LPT slave mode. This switch causes Norton Ghost to automatically go into LPT slave mode, and is the equivalent of selecting LPT Slave from the main menu.

For more information, see “Peer-to-peer connections” on page 99.

-memcheck

Activates internal memory usage checking for Technical Support.

-nofile

Disables the Image File Selection dialog box. Useful when opening directories with large numbers of files and slow links.

-nolilo

Does not attempt to patch the LILO boot loader after a clone. If you use the -nolilo switch, you need to start from a floppy disk after the clone, and then run /sbin/lilo as the root user to reinstall LILO.

-noscsi

Disables access to SCSI devices via ASPI.

-ntc-

Disables NTFS contiguous run allocation.

-ntchkdsk

Cloned NTFS volume will have the CHKDSK bit set. This causes Windows NT to check the integrity of the volume when it is started.

-ntd

Enables NTFS internal diagnostic checking.

-ntic

Ignores the NTFS volume CHKDSK bit. Norton Ghost checks the CHKDSK bit on an NTFS volume before performing operations. When Norton Ghost indicates that the CHKDSK bit is set, run CHKDSK on the volume to ensure that the disk is in a sound state before cloning.
Command-line switches

-ntiid

By default, Norton Ghost copies partitions participating in an NT volume set, stripe set, or mirror set using image all sector-by-sector copying. This switch forces Norton Ghost to ignore the Windows NT volume set partition status and clone the partition as if it were an NTFS partition to let it be intelligently cloned on a file-by-file basis. Take care when using this switch. Do not use the -ntiid switch with volume sets and stripe sets.

To clone mirrored partitions (also known as NT software RAID partitions)
1. With Windows NT disk administrator, break the mirror set.
2. Using the -ntiid switch, clone one of the mirror partitions.
3. Resize as desired.
   Partitions can only be resized by Norton Ghost during a DISK operation. When performing a partition operation, the target partition size must already be established.
4. After cloning, recreate a mirror set using the Windows NT disk administrator.
   The disk administrator creates the partitions in the mirror set.

-ntil

Ignores NTFS log file check (inconsistent volume).

-or

Override. Allows the override of internal space and integrity checks. Avoid using this switch.

-pwd and -pwd=x

Specifies that password protection be used when creating an image file.

x indicates the password for the image file. If no password is given in the switch, Norton Ghost prompts for one. You can enter a maximum of 10 alphanumeric characters.

-pmbr

Specifies that the master boot record of the destination disk be preserved when performing a disk-to-disk or image-to-disk cloning operation.
-quiet

Quiet mode. Disables status updates and user intervention.

-rb

Restarts after finishing a load or copy. After completing a load or copy operation, the target computer must be restarted so that the operating system can load the new disk/partition information. Normally, Norton Ghost prompts the user to restart or exit. -rb tells Norton Ghost to automatically restart after completing the clone.

For more information, see “-fx” on page 80.

-skip=x

Skip file. Causes Norton Ghost to exclude the indicated files during a create or load operation. A skip entry can specify a single file, directory, or multiple files using the * wildcard. File names must be given in short file name format and all path names are absolute. Only FAT system files can be skipped. It is not possible to skip files on NTFS or other file systems. The skip switch may only be included in the command line once. To specify multiple skip entries, they must be included in a text file indicated using -skip=@skipfile. The format of the skip text file skipfile matches the format used with the CRC32 vexcept option.

Examples:

- -skip=\windows\user.dll
  Skips the file User.dll in the Windows directory.
- -skip=*\readme.txt
  Skips any file called Readme.txt in any directory.
- -skip=\ghost\*.dll
  Skips any file ending with .dll in the Ghost directory.
Command-line switches

- **-skip=\program\**
  Skips the program files directory (note the short file name).

- **-skip=@skipfile.txt**
  Skips files as outlined in Skipfile.txt. For example, Skipfile.txt contains:
  
  ```
  *\*.tmt
  [partition:1]
  \windows\
  *\*.exe
  [Partition:2]
  *\*me.txt
  ```

  This would skip all *.tmt files on any partition, the Windows directory and any *.exe files on the first partition, and any file that ends with me.txt on the second partition.

- **-span**

  Enables spanning of image files across volumes.

- **-split=x**

  Splits image file into x MB spans. Use this switch to create a forced size volume set. For example, if you want to force smaller image files from a 1024 MB drive, you could specify 200 MB segments. For example,

  ```
  ghostpe.exe -split=200
  ```

  divides the image into 200 MB segments.

- **-sze**

  Sets the size for the destination partitions for either a disk load or disk copy operation.

  For more information, see “Setting a destination size for the clone switch” on page 92.

- **-tapebuffered**

  Default tape mode. Sets the ASPI driver to report a read/write as successful as soon as the data has been transferred to memory. Useful when using older or unreliable tape devices or sequential media.
-tapeeject

Forces Norton Ghost to eject the tape following a tape operation. If the
tape drive does not support remote ejection you must eject and insert the
tape manually before further use. Earlier versions ejected the tape by
default. By default, Norton Ghost does not eject the tape. It rewinds the
tape before exiting to DOS.

-tapesafe

Sets the ASPI driver to report a read/write as successful only when the data
has been transferred to the physical medium. Useful when using older or
unreliable tape devices or sequential media.

-tapebsize

Specifies the tape block size in units of 512 bytes.

-tapespeed=x

Allows control of tape speed. Where x equals 0 to F. 0 is the default. 1-F
increases tape speed. Only use this when the tape does not work correctly
at the speed used by Norton Ghost.

-tapeunbuffered

Sets the ASPI driver to report a read/write as successful only when the data
has been transferred to the tape drive. (It is possible that this occurs before
the data is physically written to the medium.)

-tcpm:\slave IP address

TCP/IP master mode. This switch causes Norton Ghost to automatically go
into TCP/IP master mode, and is the equivalent of selecting TCP/IP Master
from the main menu. The IP address of the slave computer may be
specified.

For more information, see “Peer-to-peer connections” on page 99.

-tcps

TCP/IP slave mode. This switch causes Norton Ghost to automatically go
into TCP/IP slave mode, and is the equivalent of selecting TCP/IP Slave
from the main menu.

For more information, see “Peer-to-peer connections” on page 99.
Command-line switches

-usbm

USB master mode. This switch causes Norton Ghost to automatically go into USB master mode, and is the equivalent of selecting USB Master from the main menu.

For more information, see “Peer-to-peer connections” on page 99.

-usbs

USB slave mode. This switch causes Norton Ghost to automatically go into USB slave mode, and is the equivalent of selecting USB Slave from the main menu.

For more information, see “Peer-to-peer connections” on page 99.

-vdw

If this switch is set, Norton Ghost uses the disk’s verify command to check every sector on the disk before it is written. This option may slow Norton Ghost operation substantially.

-ver

Shows the version number of Norton Ghost.

-ver=value

Tests the version of Norton Ghost. If Norton Ghost is older than the specified version, it aborts and exits, otherwise it proceeds as normal. The version number should be specified without the period. For example, Norton Ghost 6.5 is -ver=650.

-z

Compresses when saving a disk or partition to an image file. The greater the compression, the slower the transmission.

- z or -z1: low compression (fast transmission)
- z2: high compression (medium transmission)
- z3 through -z9: higher compression (slower transmission)
Clone switch syntax

The syntax for the clone switch is:

-clone,MODE={operation},SRC={source},DST={destination}, [SZE|size],[SZE|size].....]

Defining the type of clone command

MODE defines the type of clone command.

MODE={copy | load | dump | pcopy | pload | pdump}

<table>
<thead>
<tr>
<th>Switch</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>copy</td>
<td>Disk-to-disk copy</td>
</tr>
<tr>
<td>load</td>
<td>File-to-disk load</td>
</tr>
<tr>
<td>dump</td>
<td>Disk-to-file dump</td>
</tr>
<tr>
<td>pcopy</td>
<td>Partition-to-partition copy</td>
</tr>
<tr>
<td>pload</td>
<td>File-to-partition load</td>
</tr>
<tr>
<td>pdump</td>
<td>Partition-to-file dump, allows multipart</td>
</tr>
<tr>
<td></td>
<td>Ghost dump selection for file</td>
</tr>
</tbody>
</table>
Cloning combination options

This table illustrates the possible cloning operations that you can perform.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Source</th>
<th>Destination</th>
</tr>
</thead>
<tbody>
<tr>
<td>copy</td>
<td>disk</td>
<td>disk</td>
</tr>
<tr>
<td>load</td>
<td>file, tape</td>
<td>disk, tape, CD writer</td>
</tr>
<tr>
<td>dump</td>
<td>disk</td>
<td>file, tape, CD writer</td>
</tr>
<tr>
<td>pcopy</td>
<td>disk:partition</td>
<td>disk:partition</td>
</tr>
<tr>
<td>pload</td>
<td>file:partition, tape:partition</td>
<td>disk:partition</td>
</tr>
<tr>
<td>pdump</td>
<td>disk:partition:partition</td>
<td>file, tape, CD writer</td>
</tr>
</tbody>
</table>

You can specify more than one partition.

Setting a source for the clone switch

SRC defines the source for the operation selected by the clone mode option.

SRC=[disk | file | tape]

<table>
<thead>
<tr>
<th>Switch</th>
<th>Source</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>disk</td>
<td>drive number</td>
<td>Source disk drive number. Numbers start at 1. For example, SRC=1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>A partition on a drive can also be specified. Numbers start at 1. For example, SRC=1:2</td>
</tr>
</tbody>
</table>
Setting a destination for the clone switch

DST defines the destination location for the operation.

DST=[disk | file | tape | cdwriter]

<table>
<thead>
<tr>
<th>Switch</th>
<th>Source</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>file</td>
<td>filename</td>
<td>The source image file name. For example, SRC= g:\source.gho</td>
</tr>
<tr>
<td></td>
<td></td>
<td>A partition in an image file can also be specified. For example, SRC=g:\source.gho:2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Files can also be read from a CD-ROM drive.</td>
</tr>
<tr>
<td>tape</td>
<td>@MTx</td>
<td>The tape drive number. Numbers start at 0. For example, SRC=@MT0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>A partition on a tape can also be specified. For example, SRC=@MT0:3</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Switch</th>
<th>Destination</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>disk</td>
<td>drive</td>
<td>The destination disk drive number. For example, DST=2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>A partition on a drive can also be specified. For example, DST=2:1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>To create a new partition, type a destination partition one greater than the existing number of partitions, if there is enough free space</td>
</tr>
<tr>
<td>file</td>
<td>filename</td>
<td>The destination image file name. For example, DST= g:\destination.gho</td>
</tr>
<tr>
<td>tape</td>
<td>@MTx</td>
<td>The tape drive number. Numbers start at 0. For example, DST=@MT0</td>
</tr>
<tr>
<td>cdwriter</td>
<td>@CDx</td>
<td>The CD writer drive number. Numbers start at 1. For example, DST=@CD1</td>
</tr>
</tbody>
</table>
## Setting a destination size for the clone switch

SZE sets the size of the destination partitions for either a disk load or disk copy operation. This is optional. Multiple partition size switches are supported.

\[
\text{SZE} | E \quad | \quad F \quad | \quad L \quad | \quad n=[xxxxM \quad | \quad mmP \quad | \quad F \quad | \quad V]\
\]

<table>
<thead>
<tr>
<th>Switch</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>n=xxxxM</td>
<td>Indicates that the nth destination partition is to have a size of xxxxMB (for example, SZE2=800M indicates partition two is to have 800 MB).</td>
</tr>
<tr>
<td>n=mmP</td>
<td>Indicates that the nth destination partition is to have a size of mm percent of the target disk. Due to partition size rounding and alignment issues, 100% physical use of disk space may not be possible.</td>
</tr>
<tr>
<td>n=F</td>
<td>Indicates that the nth destination partition is to remain the same size on the destination as it was on the source. This is referred to as fixed size.</td>
</tr>
<tr>
<td>n=V</td>
<td>Indicates that the partition may be made bigger or smaller depending on how much disk space is available. This is the default.</td>
</tr>
<tr>
<td>E</td>
<td>The sizes of all partitions remain fixed.</td>
</tr>
<tr>
<td>F</td>
<td>The sizes of all partitions except the first remain fixed. The first partition uses the remaining space.</td>
</tr>
<tr>
<td>L</td>
<td>The sizes of all partitions except the last remain fixed. The last partition uses the remaining space.</td>
</tr>
</tbody>
</table>
## Examples of clone switch usage

The following table describes clone switches and their functions.

<table>
<thead>
<tr>
<th>Switch</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>ghostpe.exe -clone,mode=copy,src=1,dst=2</td>
<td>Copy local disk one to local disk two.</td>
</tr>
<tr>
<td>ghostpe.exe -clone,mode=dump,src=2,dst=\drive2.gho -lpm</td>
<td>Connect a master computer using LPT to another computer running Norton Ghost in slave mode, and save a disk image of local disk two to the remote file c:\drive2.gho.</td>
</tr>
<tr>
<td>The slave computer can be started with ghostpe.exe -lps</td>
<td></td>
</tr>
<tr>
<td>ghostpe.exe -clone,mode=pcopy,src=1:2,dst=2:1</td>
<td>Copy the second partition of local disk one to the first partition of local disk two.</td>
</tr>
<tr>
<td>ghostpe.exe -clone,mode=load,src=g:\2prtdisk.gho,dst=2,sze1=60P,sze2=40P</td>
<td>Load disk two from an image file and resize the destination partitions into a 60:40 allocation.</td>
</tr>
<tr>
<td>ghostpe.exe -clone,mode=copy,src=1,dst=2,sze2=F</td>
<td>Clone a two partition disk and keep the second partition on the destination disk the same size as on the source disk, and let the first partition use the remaining space, leaving no unallocated space.</td>
</tr>
<tr>
<td>ghostpe.exe -clone,mode=load,src=g:\3prtdisk.gho,dst=1,sze1=450M,sze2=1599M,sze3=2047M</td>
<td>Load disk one from an image file and resize the first partition to 450 MB, the second to 1599 MB, and the third to 2047 MB.</td>
</tr>
<tr>
<td>ghostpe.exe -clone,mode=load,src=g:\2prtdisk.gho,dst=1,sze1.</td>
<td>Load a disk from an image file and resize the last partition to fill the remaining space.</td>
</tr>
<tr>
<td>ghostpe.exe -clone,mode=copy,src=2:2,dst=@MT0</td>
<td>Create an image file of the second partition on disk 2 onto the first tape drive.</td>
</tr>
</tbody>
</table>
| ghostpe.exe -clone,mode=pdump,src=2:1:4:6,dst=d:\part146.gho          | Create an image file with only the selected partitions. This is an example of selecting partitions 1, 4, and 6 from disk 2.
CRC32 switch usage

CRC checking works file-by-file with FAT partitions. NTFS partitions are CRC-checked within an image file by each MFT table. It is not possible at present to obtain a list of files failing a CRC check with an NTFS file system. When a CRC file is created for an NTFS partition, only a single CRC value is generated. You can also create a CRC file from an image file, and verify against a disk.

The full syntax for this switch is:

```
-CRC32,action={create | verify | pcreate | pverify | dcreate | dverify},src={{DiskSpec}|{PartSpec}|{File}},crcfile={File},vlist={File},vexcept={File}
```

The following parameters can be used with the -CRC32 switch:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>create</td>
<td>Create an ASCII CRC32 file from a disk.</td>
</tr>
<tr>
<td>verify</td>
<td>Verify a disk from a CRC32 file.</td>
</tr>
<tr>
<td>pcreate</td>
<td>Create an ASCII CRC32 file from a partition.</td>
</tr>
<tr>
<td>pverify</td>
<td>Verify a partition from an ASCII CRC32 file.</td>
</tr>
<tr>
<td>dcreate</td>
<td>Create an ASCII CRC32 file from an image file.</td>
</tr>
<tr>
<td>dverify</td>
<td>Verify an image file from an ASCII CRC32 file.</td>
</tr>
<tr>
<td>crcfile</td>
<td>ASCII CRC32 file (default=Ghost.crc ).</td>
</tr>
<tr>
<td>vlist</td>
<td>Verification list file (default=Ghost.ls).</td>
</tr>
<tr>
<td>vexcept</td>
<td>Verification exception file (no default).</td>
</tr>
</tbody>
</table>
### Examples of -CRC32 usage

<table>
<thead>
<tr>
<th>Switch</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>ghostpe.exe -fcr</code></td>
<td>Create a CRC32 file (called Ghost.crc) while making an image file.</td>
</tr>
<tr>
<td><code>ghostpe.exe -fcr=d:\test.crc</code></td>
<td>Create a CRC32 file while making an image file with a different name.</td>
</tr>
<tr>
<td><code>ghostpe.exe -CRC32,action=create,src=1,crcfile=ghost.crc</code></td>
<td>Create a list of files and CRC32 values for a disk.</td>
</tr>
<tr>
<td><code>ghostpe.exe -crc32,action=dverify,src=x:dumpfile.gho,crcfile=ghost.crc</code></td>
<td>Verify the list against an image file.</td>
</tr>
<tr>
<td><code>ghostpe.exe -crc32,action=pverify,src=1:2,crcfile=filename.crc:2</code></td>
<td>Verify a partition in an image file with multiple partitions.</td>
</tr>
</tbody>
</table>

This example verifies that partition 2 on disk 1 is the same as partition 2 in the CRC file.

- `ghostpe.exe -crc32,action=create`
  - Note that the default disk is the primary drive, the default ASCII CRC32 file is Ghost.crc.
  - Create an ASCII CRC32 file from the primary hard drive.

- `ghostpe.exe -CRC32,action=create,src=2,crcfile=myfile.txt`
  - Same as previous except that you specify the disk and ASCII CRC32 file. This example uses disk 2 as the source drive and the output file as Myfile.txt.
  - Create an ASCII CRC32 file.

- `ghostpe.exe -CRC32,action=verify`
  - The default disk is the primary drive and the default ASCII CRC32 file is Ghost.crc (in the current directory). In addition, the default verification list file is Ghost.ls.
  - Verify the contents of the primary disk against a CRC32 file.
Command-line switches

<table>
<thead>
<tr>
<th>Switch</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>ghostpe.exe -CRC32, action=verify, src=1, crcfile=myfile.txt, vlist=myfile.out</td>
<td>Verify the contents of the primary disk against a CRC32 file.</td>
</tr>
<tr>
<td>Same as previous but specifies the disk, CRC file, and list file. This example uses disk 1 as the source drive, Myfile.txt as the ASCII CRC32 file, and Myfile.out as the verification list file.</td>
<td></td>
</tr>
<tr>
<td>ghostpe.exe -CRC32, action=verify, src=1, crcfile=myfile.txt, vlist=myfile.out, vexcept=myfile.exc</td>
<td>Same as above with the inclusion of the EXCEPTION argument that excludes compared files based upon its entries.</td>
</tr>
</tbody>
</table>

vexcept=filename

Specifies files that are not checked with CRC. This is normally used to exclude files that are always changed on start up. A sample exception file follows.

[ghost exclusion list]
\PERSONAL\PHONE
[partition:1]
\WINDOWS\COOKIES\*. *
\WINDOWS\HISTORY\*
\WINDOWS\RECENT\*
\WINDOWS\USER.DAT
\WINDOWS\TEMPOR~1\CACHE1\*
\WINDOWS\TEMPOR~1\CACHE2\*
\WINDOWS\TEMPOR~1\CACHE3\*
\WINDOWS\TEMPOR~1\CACHE4\*
[partition:2]
* *.1
[end of list]

The exclusion list is case-sensitive; all files should be specified in upper case. The *wildcard follows UNIX rules, it is more powerful than the MS-DOS *. In particular it matches the . as well as any other character, but other characters can follow the *. Thus, a wildcard of *br* matches any files containing the letters “br”, for example, brxyz.txt, abr.txt, and abc.dbr.
The specification of `\WINDOWS\COOKIES\*.` in the example above means match all files in the subdirectory `\WINDOWS\COOKIES` that have an extension. To match all files with or without an extension, `WINDOWS\COOKIES\*` should be used.

Short file names should be used in exclusion files. Files specified before the first `[Partition:x]` heading are used to match files in any partition.

A directory of `*` matches any subdirectory, regardless of nesting. The above exclusion file matches any file with an extension of `.1` in any subdirectory on the second partition. Apart from this, wildcards should be used for files, not for directories.
Setting up the hardware and transfer methods

Before using Norton Ghost, consider the hardware and transfer requirements for the transfer method that you want to use. Ensure that all hard drives are installed correctly and that the BIOS of the system is configured and shows the valid parameters of the drives.

Peer-to-peer connections

Peer-to-peer connections enable Norton Ghost to run on two computers, transferring drives and partitions and using image files between them.

The following table describes different cloning situations, and the master/slave relationship.

<table>
<thead>
<tr>
<th>Action</th>
<th>Master</th>
<th>Slave</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disk-to-disk copy</td>
<td>Computer containing source disk</td>
<td>Computer containing destination disk</td>
</tr>
<tr>
<td>Disk-to-image file copy</td>
<td>Computer containing source disk</td>
<td>Computer receiving destination image file</td>
</tr>
<tr>
<td>Image file-to-disk copy</td>
<td>Computer containing destination disk</td>
<td>Computer containing source image file</td>
</tr>
<tr>
<td>Partition-to-partition copy</td>
<td>Computer containing source partition</td>
<td>Computer containing destination partition</td>
</tr>
<tr>
<td>Partition-to-image file copy</td>
<td>Computer containing source partition</td>
<td>Computer receiving destination image file</td>
</tr>
<tr>
<td>Image file-to-partition copy</td>
<td>Computer containing destination partition</td>
<td>Computer containing source image file</td>
</tr>
</tbody>
</table>
Select which computer is the master (the computer from which you control the connection), and which is the slave (the other computer participating in the connection). All operator input must occur on the master computer.

**LPT or USB connections**

On an LPT/parallel port connection, use a parallel connection cable and a parallel port to connect the computers. For data transfer of approximately 19-25 MB/min, Norton Ghost provides support for the Parallel Technologies universal DirectParallel cable. For peer-to-peer USB port connections use a USB cable that supports a host-to-host connection and a data transfer of approximately 20-30 MB/min.

ECP is the best option for LPT connections and has a data transfer rate of approximately 5 MB/min. Norton Ghost must be running under DOS on both computers.

For more information, see "USB and DirectParallel Cables" on page 103.

**TCP/IP connections**

Connect the computers with an ethernet or token ring network interface card and an established network connection, which includes one of the following:

- Crossover ethernet cable
  (pins 1236 > 3612)
- Coaxial cable
- Standard cables with hub or MAU

Install a network interface card (NIC).

**SCSI tape driver**

To use Norton Ghost with a SCSI tape device, the tape media and the tape device must have an Advanced SCSI Programming Interface (ASPI) driver for DOS installed. The driver is installed in the Config.sys file as shown in the example below:

```
device=C:\scsitape\aspi4dos.sys
```

Refer to the documentation included with the SCSI tape device for more information.
Removable media

The removable media drive, media, and media drivers for use in DOS are required.

CD-ROM usage

A CD writer and blank CD-R media are required.

For more information, see “Image files and CD writers” on page 47.

Internal drives

To work with internal drives, ensure that each of the drives is properly configured. This means that if fixed IDE drives are in use, the jumpers on the drives are set up correctly, and the BIOS of the computer is configured for the disk arrangement. Both the source and the destination drives must be free from file corruption and physical hard drive defects.

Third party device

Install the DOS driver as outlined in the device documentation.
Setting up the hardware and transfer methods
This appendix provides detail on USB and DirectParallel cables that can be used with Norton Ghost.

**Parallel Technologies cables**

Parallel Technologies USB and DirectParallel® Universal Fast Cable provide high-speed data transfer and can significantly increase Norton Ghost performance.

USB and DirectParallel connection cables are available directly from Parallel Technologies.

- Via Web site: [http://www.lpt.com](http://www.lpt.com)
- Via telephone: 800.789.4784 (U.S.)
  425.869.1119 (International)
- Via fax: 253.813.8730
- Via email: sales@lpt.com

The USB and DirectParallel connection cables can also be used for high-speed computer-to-computer file transfer and networking in Windows 9x and Windows 2000. Norton Ghost contains DirectParallel driver technology from Parallel Technologies, Inc., the developers of the Direct Cable Connection computer-to-computer technology built into Windows 9x and Windows 2000. The DirectParallel drivers and cables contain patent-pending parallel port interface technology.
Other USB cables

The following USB peer-to-peer cables can also be used with Norton Ghost:

- EzLink USB Instant Network, model 2710
- USB LinQ Network
- BusLink USB to USB File Transfer cable, model UFT06
Norton Ghost can clone many different Linux systems. However, ensure that the position of the disk and the boot configuration are appropriate for a cloning task. You can use Ghost Explorer with ext2 files. However, there are some restrictions.

**Supported configurations**

Norton Ghost can clone many different Linux distributions successfully. However, Norton Ghost is sensitive to any possible changes in ext2 file system and LILO specifications. If changes are made to these specifications, Norton Ghost may no longer support the Linux distribution. Symantec attempts to release new builds of Ghost promptly to address such changes.

Norton Ghost is not sensitive to kernel versions. Use the -nolinux and -nolilo command-line switches to resolve problems with any incompatibilities.

For more information, see “Command-line switches” on page 75.

Norton Ghost clones any x86-based Linux system with full support for ext2 file systems (type 0x83) containing 1 KB, 2 KB, or 4 KB block sizes. Other file systems, for example, reiserfs, are cloned on a sector-by-sector basis and cannot be resized during cloning.

Linux systems that use LILO as their boot loader in the MBR or in the active ext2 partition are supported with some exceptions. Any references to a disk other than the first hard disk in the system (/dev/hda or /dev/sda) are not supported. The /boot and root file systems must be on the first hard disk. /boot can be a directory within the root file system.

Norton Ghost supports type 0 and type 1 Linux swap file systems (type 0x82).
Norton Ghost partially supports Linux extended partitions (type 0x85). It clones file systems inside these extended partitions, but restores them as DOS extended partitions. This is not known to cause problems with Linux systems after cloning.

**Position of disk**

Linux is sensitive to the position of the disk in hardware. A system running on the primary master disk does not run if the disk is mounted as the primary slave or as the secondary master. Norton Ghost does not resolve this issue.

**Boot configuration**

Norton Ghost uses the file /etc/lilo.conf to determine the boot configuration. If this file does not match the boot configuration, Norton Ghost may be unable to patch LILO during cloning. It does not support the default keyword in Lilo.conf, so the first target specified should be the default target.

If a different boot loader is used, for example, grub, or the above conditions are not met, Norton Ghost clones the system but the new disk probably won’t boot afterwards. It should be started from a floppy disk or CD, and the boot loader should be reinstalled by running /sbin/lilo or an equivalent. Always have a boot disk available in case of problems starting a Linux system after cloning.

**Norton Ghost utility support**

Ghost Explorer substantially supports ext2 file systems within image files, including the restoration, deletion, and addition of files within these file systems. Problems arise when files are manipulated that have names that are illegal on Windows. Ghost Explorer cannot manipulate device files or symbolic links. Sparse files are expanded on restoration, and hard links are broken.

GDisk does not create any Linux file systems, or recognize any partitions within a Linux extended partition.
Troubleshooting

A Norton Ghost error message consists of an error number, a description, and possibly a suggestion to remedy the problem. Make sure that you are running the latest version of Ghost as many errors have been fixed.

A Ghosterr.txt file is generated when an abort error occurs.

For more information, see “Diagnostics” on page 111.

Further information is available on the Norton Ghost Technical Support Web site.

For more information, see “Service and support solutions” on page 115.

<table>
<thead>
<tr>
<th>Error code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>10098</td>
<td>The partition number must be included in the command-line switches. For more information, see “Command-line switches” on page 75.</td>
</tr>
<tr>
<td>10010, 10014, 11000</td>
<td>Incorrect path/file syntax. Ensure that the path and file name are correct. Also make sure that you have the proper user rights to read or create the image file.</td>
</tr>
<tr>
<td>19913</td>
<td>Can’t find the BOOTP/DHCP server. Ensure that the computer is connected to the network and that a BOOTP or DHCP server is set up for this subnet.</td>
</tr>
</tbody>
</table>
## Troubleshooting

<table>
<thead>
<tr>
<th>Error code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>19916</td>
<td>Duplicate IP address detected. An IP address has been allocated that is already in use.</td>
</tr>
<tr>
<td>CDR101: Not ready reading drive X, Abort, Retry, Fail</td>
<td>A system error message. This error is not caused by Norton Ghost. It is caused by malfunctioning hardware or software configurations. The image file on the CD is not readable. To verify this, go into DOS and copy the image file off of the CD-ROM using copy verification.</td>
</tr>
</tbody>
</table>
The Wattcp.cfg network configuration file

The Wattcp.cfg configuration file contains the TCP/IP networking configuration details for Norton Ghost.

The Wattcp.cfg file specifies the IP address and the subnet mask of the computer and lets you set other optional network parameters. The file should be located in the current directory when Ghostpe.exe is started.

Comments in the file start with a semicolon (;). Options are set using the format option = value. For example:
receive_mode=5;set receive mode

The keywords in the Wattcp.cfg configuration file are as follows:

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
</tr>
</thead>
</table>
| IP      | Specifies the IP address of the local computer. Each computer must have a unique IP address. Norton Ghost supports the use of DHCP and BOOTP servers and defaults to using them when the IP address is left blank or is invalid. DHCP and BOOTP provide automatic assignment of IP addresses to computers. This lets identical boot disks be used on computers with similar network cards.  
  Example: IP=192.168.100.10 |
| Netmask | Specifies the network IP subnet mask.  
  Example: NETMASK=255.255.255.0 |
The Wattcp.cfg network configuration file

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gateway (optional)</td>
<td>Specifies the IP address of the gateway. This option is required when routers are present on the network and when participating computers are located on different subnets. Example: GATEWAY=192.168.100.1</td>
</tr>
<tr>
<td>Bootpto (optional)</td>
<td>Overrides the time-out value (in seconds) for BOOTP/DHCP. Example: BOOTPTO=60</td>
</tr>
<tr>
<td>Receive_Mode (Ethernet only)</td>
<td>Overrides the automatically configured packet driver mode used by Norton Ghost. The modes in order of preference are 4, 5, and 6. The default mode is 4.</td>
</tr>
</tbody>
</table>
This appendix describes the diagnostics reports that Norton Ghost can produce, and some network testing techniques that may be useful for diagnostics.

**Hard drive detection and diagnostic information**

Norton Ghost can generate several diagnostic reports outlining the hard drive devices detected, other system-related information, and error conditions when they are detected.

**Norton Ghost abort error file (Ghosterr.txt)**

An error message consists of an error number, a description, and possibly a suggestion of how to remedy the problem.

The Norton Ghost abort error file includes these details along with additional drive diagnostics and details required to assist Technical Support in diagnosing the cause of the problem.

The Norton Ghost abort error file is generated when an erroneous condition is detected by the software that Norton Ghost is unable to recover from or work around. The Ghosterr.txt file is generated in the current directory. If this location is read-only, the Ghosterr.txt file output location should be redirected. The location and file name of the abort file generated by Norton Ghost during an abort can be altered using the -afile=drive: \path \file name command-line switch.

For more information, see “Troubleshooting” on page 107.
Diagnostics

Listing hard disk geometry diagnostics

A list of all detected hard drives on the system and their associated geometry values can be shown on-screen using the command-line switch -di. To generate a file containing the details, use the following DOS redirect output:

```
c:\>ghostpe.exe-di>drives.txt
```

Creating a full diagnostic statistics dump summary

A full diagnostic statistics dump summary file contains the detected hard disk geometry details along with other Norton Ghost statistics. The full Norton Ghost diagnostic statistics dump can be created using the command-line switch -dd. The default statistics dump file name is Ghststat.txt. The location and file name of a file generated by Norton Ghost can be altered by adding the -dfile=drive:\path\filename command-line switch.

Testing TCP/IP functionality

There are several testing utilities available in the Microsoft TCP/IP application suite. An example of two Windows 95 TCP/IP utilities, Ping.exe and Winipcfg.exe, is included below. On Windows NT, the equivalent utilities are Ping.exe and Ipconfig.exe.

The Ping.exe utility shows TCP/IP networking response and can be used to show connectivity between computers. For a mapped network volume connection, a client can ping the server and vice versa to check that they have basic connectivity at any time.
Pinging a local host shows basic local TCP/IP functionality. The address used in the following example identifies the local host on the network.

**Pinging a local host**

In a Windows DOS prompt dialog box on a Windows 95 computer with a computer name Win95PC1, the following command is entered:

`c:\> ping LocalHost
Pinging Win95PC1 [127.0.0.1] with 32 bytes of data:
Reply from 127.0.0.1: bytes=32 time<10ms TTL=128
Reply from 127.0.0.1: bytes=32 time<10ms TTL=128
Reply from 127.0.0.1: bytes=32 time<10ms TTL=128
Reply from 127.0.0.1: bytes=32 time<10ms TTL=128

This test indicates that the TCP/IP stack is installed and operating.
Service and support solutions

Service and support information is available from the Help system of your Symantec product. Click the Service and Support topic in the Help index.

Technical support

Symantec offers several technical support options:

- Online Service and Support

  Connect to the Symantec Service & Support Web site at http://service.symantec.com, select your user type, and then select your product and version. This gives you access to current hot topics, knowledge bases, file download pages, multimedia tutorials, contact options, and more.

- PriorityCare telephone support

  PriorityCare fee-based telephone support services are available to all registered customers. For complete information, please call our automated fax retrieval service at (800) 554-4403 and request document 935000.

  You can also access the PriorityCare number for your product through the Service & Support Web site. You’ll be led through the online options first, and then to the telephone contact options available for your product and version.

- Automated fax retrieval

  Use your fax machine to receive general product information, fact sheets, and product upgrade order forms by calling (800) 554-4403. For technical application notes, call (541) 984-2490.
Support for old and discontinued versions

When a new version of this software is released, registered users will receive upgrade information in the mail. Telephone support will be provided for the old version for up to twelve months after the release of the new version. Technical information may still be available through the Service & Support Web site (http://service.symantec.com).

When Symantec announces that a product will no longer be marketed or sold, telephone support will be discontinued 60 days later. Support will be available for discontinued products from the Service & Support Web site only.

Customer service

Access customer service options through the Service & Support Web site at http://service.symantec.com. From this site, you can receive assistance with non-technical questions, and for information on how to do the following:

- Subscribe to the Symantec Support Solution of your choice.
- Obtain product literature or trialware.
- Locate resellers and consultants in your area.
- Replace missing or defective CD-ROMS, disks, manuals, and so on.
- Update your product registration with address or name changes.
- Get order, return, or rebate status information.
- Access customer service FAQs.
- Post a question to a Customer Service representative.

For upgrade orders, visit the online upgrade center at: http://www.symantecstore.com

Worldwide service and support

Technical support and customer service solutions vary by country. For information on Symantec and International Partner locations outside of the United States, please contact one of the service and support offices listed below, or connect to http://service.symantec.com and select your region under the Global Service and Support.
# Service and support offices

## North America

<table>
<thead>
<tr>
<th>Symantec Corporation</th>
<th><a href="http://www.symantec.com/">http://www.symantec.com/</a></th>
</tr>
</thead>
<tbody>
<tr>
<td>175 W. Broadway</td>
<td></td>
</tr>
<tr>
<td>Eugene, OR 97401</td>
<td></td>
</tr>
<tr>
<td>U.S.A.</td>
<td></td>
</tr>
<tr>
<td>Automated Fax Retrieval</td>
<td>(800) 554-4403</td>
</tr>
<tr>
<td></td>
<td>(541) 984-2490</td>
</tr>
</tbody>
</table>

## Argentina and Uruguay

<table>
<thead>
<tr>
<th>Symantec Region Sur</th>
<th><a href="http://www.service.symantec.com/mx">http://www.service.symantec.com/mx</a></th>
</tr>
</thead>
<tbody>
<tr>
<td>Cerrito 1054 - Piso 9</td>
<td>+54 (11) 5382-3802</td>
</tr>
<tr>
<td>1010 Buenos Aires</td>
<td></td>
</tr>
<tr>
<td>Argentina</td>
<td></td>
</tr>
</tbody>
</table>

## Asia/Pacific Rim

<table>
<thead>
<tr>
<th>Symantec Australia</th>
<th><a href="http://www.symantec.com/region/reg_ap/">http://www.symantec.com/region/reg_ap/</a></th>
</tr>
</thead>
<tbody>
<tr>
<td>Level 2, 1 Julius Avenue</td>
<td>+61 (2) 8879-1000</td>
</tr>
<tr>
<td>North Ryde, NSW 2113</td>
<td>Fax: +61 (2) 8879-1001</td>
</tr>
<tr>
<td>Sydney</td>
<td></td>
</tr>
<tr>
<td>Australia</td>
<td></td>
</tr>
</tbody>
</table>

## Brazil

<table>
<thead>
<tr>
<th>Symantec Brasil</th>
<th><a href="http://www.service.symantec.com/br">http://www.service.symantec.com/br</a></th>
</tr>
</thead>
<tbody>
<tr>
<td>Market Place Tower</td>
<td>+55 (11) 5189-6300</td>
</tr>
<tr>
<td>Av. Dr. Chucri Zaidan, 920 12º andar</td>
<td>Fax: +55 (11) 5189-6210</td>
</tr>
<tr>
<td>São Paulo - SP</td>
<td></td>
</tr>
<tr>
<td>CEP: 04583-904</td>
<td></td>
</tr>
<tr>
<td>Brasil, SA</td>
<td></td>
</tr>
</tbody>
</table>

## Europe, Middle East, and Africa

<table>
<thead>
<tr>
<th>Symantec Customer Service Center</th>
<th><a href="http://www.symantec.com/region/reg_eu/">http://www.symantec.com/region/reg_eu/</a></th>
</tr>
</thead>
<tbody>
<tr>
<td>P.O. Box 5689</td>
<td>+353 (1) 811 8032</td>
</tr>
<tr>
<td>Dublin 15</td>
<td></td>
</tr>
<tr>
<td>Ireland</td>
<td></td>
</tr>
</tbody>
</table>
Service and support solutions

**Mexico**

Symantec Mexico
Blvd Adolfo Ruiz Cortines, No. 3642 Piso 14
Col. Jardines del Pedregal
Ciudad de México, D.F.
C.P. 01900
México

http://www.service.symantec.com/mx
+52 (5) 661-6120

**Other Latin America**

Symantec Corporation
9100 South Dadeland Blvd.
Suite 1810
Miami, FL 33156
U.S.A.

http://www.service.symantec.com/mx

---

**Subscription policy**

If your Symantec product includes virus, firewall, or web content protection, you might be entitled to receive protection updates via LiveUpdate. The length of the subscription could vary by Symantec product.

When you near the end of your subscription, you will be prompted to subscribe when you start LiveUpdate. Simply follow the instructions on the screen. After your initial subscription ends, you must renew your subscription before you can update your virus, firewall, or web content protection. Without these updates, your vulnerability to attack increases. Renewal subscriptions are available for a nominal charge.

Every effort has been made to ensure the accuracy of this information. However, the information contained herein is subject to change without notice. Symantec Corporation reserves the right for such change without prior notice.

July 13, 2001
Norton Ghost™

CD Replacement Form

CD REPLACEMENT: After your 60-Day Limited Warranty, if your CD becomes unusable, fill out and return 1) this form, 2) your damaged CD, and 3) your payment (see pricing below, add sales tax if applicable), to the address below to receive replacement CD.

DURING THE 60-DAY LIMITED WARRANTY PERIOD, THIS SERVICE IS FREE. You must be a registered customer in order to receive CD replacements.

FOR CD REPLACEMENT

Please send me: ___ CD Replacement

Name ________________________________________________________________________________________________________________

Company Name _______________________________________________________________________________________________________

Street Address (No P.O. Boxes, Please)_____________________________________________________________________________________

City ______________________________________________________________________ State _______ Zip/Postal Code _________________

Country* _________________________________________________________Daytime Phone _______________________________________

Software Purchase Date _________________________________________________________________________________________________

*This offer limited to U.S., Canada, and Mexico. Outside North America, contact your local Symantec office or distributor.

Briefly describe the problem:_____________________________________________________________________________________________

______________________________________________________________________________________________________________________

FORM OF PAYMENT ** (CHECK ONE):

___ Check (Payable to Symantec)  Amount Enclosed $ _________ __ Visa       __ Mastercard      __  American Express

Credit Card Number ___________________________________________________________________________________Expires __________

Name on Card (please print) ________________________________________________ Signature ___________________________________

**U.S. Dollars. Payment must be made in U.S. dollars drawn on a U.S. bank.

MAIL YOUR CD REPLACEMENT ORDER TO:

Symantec Corporation
Attention: Order Processing
175 West Broadway
Eugene, OR 97401-3003  (800) 441-7234

Please allow 2-3 weeks for delivery within the U.S.

Symantec and Norton Ghost are trademarks of Symantec Corporation. Other brands and products are trademarks of their respective holders.

© 2001 Symantec Corporation. All rights reserved. Printed in the U.S.A.
Symbols
#e=filename switch 76
? switch 80
@filename switch 75

A
Abort log 76, 111
Activating
  Partitions 67
afile=filename switch 76
ASPI driver 100
auto switch 76
Automation
  Clone switch and examples 89, 93
  Close on completion 80
  Quiet mode 85
  Restart on completion 85
  Switches 75-88
  Version checking 87, 88

B
bfc=x switch 76
Boot disk 26
Boot menu 68
bootcd switch 76

C
Cables 103
CD disk
  Bootable 29, 34, 38, 47
  CD writers 38, 47
  Supported writers 47
CD-R/RW
  Cloning to 38
CD-ROM 101
chkimg, filename switch 76
crnm switch 76, 89
Cloning
  Compression 42
  Speed 42
  To a CD-R/RW 38
  Windows 2000 50
Command line 39
  Examples 93-96
  Norton Ghost 75-88
Compression 34, 42
Copy command 89
crc32 switch 43, 77, 77, 78
crcignore switch 77
Creating
  Partition 60

D
Data checking 43
Data compression 42
dd switch 77
Deactivating
  Partitions 67
Decompression 42
Deleting
  Partitions 65
dfile=filename switch 77
di switch 78
Diagnostics 111-113
Disk
  Large 73
  Status 62
dl=number switch 78
DOS
  MS-DOS 24
  PC-DOS 24
dst switch 91
Dump
  Command 89
Dynamic disks 50
Image files (continued)
  Split. See Image files, multisegment
  Standard 43
  Tape drives 45
  Viewing contents 52
Internal drives 101

J
  jlx=filename switch 82

L
  License number 26
  Linux 26, 28, 52, 62, 80
  LiveUpdate 14
  Load
    Command 89
    lockinfo switch 82
    locktype=type switch 82
    lpm switch 82
    lps switch 83
    LPT port 100
      Support 18

M
  Master 99
  MBR, reinitializing 59
  memcheck switch 83
  Mode switch 89
  MS-DOS 24

N
  Network
    Performance 42
    nofile switch 83
    nolilo switch 83
    Norton Ghost
      Updating 14
    noscsi switch 83
    ntc switch 83
    ntdiskswitch switch 83
    ntd switch 83
    ntic switch 83
  ntid switch 84
  ntil switch 84

O
  Operations. See also Procedures
  or switch 84

P
  Parallel port transfer
    Automation 82, 88
    Setup 99
  Partition
    Creating 60
    Status 62
  Partitions 57
    Activating
      Deactivating 67
    Cloning 33
      Hiding 67
  Password 84
  PC-DOS 24
  pcopy command 89
  pdump command 89
  Peer-to-peer connections 99
  Performance network 42
  ping utility 112
  pload command 89
  pmbr switch 84
  Procedures
    Disk cloning 28
      From image file 32
      To disk 28
      To image file 30
    Partition cloning 33
      From image file 36
      To image file 35
      To partition 33
    pwd, -pwd=x switch 84

Q
  quiet switch 85

Search the online help index for more information. 123
R
RAID 50, 84
rb switch 85

S
SCSI tape
   drives 46
   Setup 100
   Switches 86-87
   Sector, bad 76, 80, 88
   Sector-by-sector copy 80
   Service and Support 115
   Setup 101
   See also SCSI Tape
skip=x switch 85
Slave 99
span switch 86
Spanning 44-45, 50
   To a CD-R/RW 38
split=x switch 86
src switch 90
Switches 39
sze switch 92

T
Tape drives 45
   tapebuffered switch 86
tapeeject switch 87
tapesafe switch 87
tapesize switch 87
tapespeed=x switch 87
tapeunbuffered switch 87
   TCP/IP 100
tcpm switch 87
tcps switch 87
   Technical Support 115

U
Uninstalling 14
Updating
   Norton Ghost 14
USB port 100
   Support 18
   usb switch 88

V
vdw switch 88
ver switch 88
ver=value switch 88
ver=except switch 96

W
Windows
   2000 50
   Boot menu 68
   Running Ghost inside 26
Wiping
   Disks 65
   Partitions 65
   Writing to a CD-R/RW disk 38, 47

Z
z switch 88